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About this Guide

Refer to the following sections to understand the audience, topics, and conventions in this guide, and the 
titles of related documents.

Audience and Scope
Written for network managers and administrators, this guide describes how to install, enable, and 
configure Cisco Secure Desktop (CSD) on a Cisco ASA 5500 Series security appliance to provide a safe 
computing environment through which a variety of remote access computers can connect.

Organization and Use
Table 1 describes the contents of this guide.

Table 1 Document Organization 

Topic Purpose

Introduction Describes the CSD capabilities, and how to access the Secure Desktop 
Manager, the browser-enabled interface for CSD administrators.

Installing and Enabling CSD Describes how to obtain the CSD software, and install or upgrade it.

Configuring Host Scan Describes how to return the results of he following endpoint scans to 
the security appliance:

 • Registry entries, filenames, process names

 • Antispyware, antivirus, and personal firewall applications and 
updates 

This chapter also describes how to configure enforcement of 
antispyware, antivirus, and personal firewall applications and updates.

Tutorial: Assigning Prelogin 
Criteria to Policies

Provides examples showing how to assign prelogin criteria to CSD 
policies and assign settings to them.

Details: Assigning Prelogin 
Criteria to Policies

Details how to specify endpoint criteria to be gathered between the 
endpoint connection to the security appliance and its return of the login 
prompt.
7
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About this Guide
Conventions
Note The Frequently Asked Questions (FAQs) in previous versions of this guide are now combined with others 
on http://supportwiki.cisco.com.

Conventions
This document uses the following conventions:

 • Boldface indicates commands and keywords that you enter literally as shown, menu options you 
choose, or buttons and check boxes you click.

 • Italics indicate arguments for which you supply values.

 • Examples show screen displays and the command line in screen font. 

Note Means reader take note. Notes contain helpful suggestions, or references to material not 
covered in the manual.

Caution Means reader be careful. Cautions alert you to actions or conditions that could result in equipment 
damage or loss of data.

Related Documentation
For more information, refer to the following documentation: 

 • Release Notes for Cisco Secure Desktop

 • Cisco ASA 5500 Series Release Notes

 • Cisco ASDM Release Notes

 • Regulatory Compliance and Safety Information for the Cisco ASA 5500 Series

Assigning Secure Desktop, 
Cache Cleaner, and Detection 
Settings to Policies

Details how to enable or disable Secure Desktop, Cache Cleaner, 
keystroke logger detection, and host emulator detection for each policy 
and assign settings for these CSD components.

Using Match Criteria to 
Configure Dynamic Access 
Policies

Describes how to match Host Scan results, CSD policies, basic Host 
Scan entries, or any combination of these criteria with any other policy 
attributes you specify to grant access rights to users dynamically.

Customizing User Banners 
and Backgrounds

Describes how to change the Secure Desktop background, text color, 
and dialog banners.

Configuring the Logging 
Level

Describes how to change the severity of the CSD events logged at the 
user endpoint.

CSD File Reference Describes the CSD files on the security appliance and the endpoint.

Table 1 Document Organization (continued)

Topic Purpose
8
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About this Guide
Obtaining Documentation and Submitting a Service Request
Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.
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H A P T E R 1

Introduction

Cisco SSL VPN solutions provide organizations with robust and flexible products for protecting the 
security and privacy of information, and can play an important part in an organization's compliance 
strategies. No single technology today addresses all security requirements under the proposed standards. 
In addition, given operating system limitations, no technology that interoperates with an operating 
system can ensure the total removal of all data, especially from an untrusted system with potentially 
malicious third party software installed. However, deployments using Cisco Secure Desktop (CSD), 
when combined with other security controls and mechanisms within the context of an effective risk 
management strategy and policy, can help reduce risks associated with using such technologies.

The following sections describe the capabilities of CSD, introduce the Secure Desktop Manager 
interface, and describe how to save configuration changes:

 • Features

 • CSD Workflow

 • Management Interface

 • Saving and Resetting the Running Configuration

Features
CSD seeks to minimize the risks posed by the use of remote devices to establish a Cisco clientless SSL 
VPN or AnyConnect Client session. CSD provides a number of features that you can configure to work 
independently or together. 

The following sections describe the CSD features:

 • Integration with Dynamic Access Policies

 • Host Scan

 • Prelogin Assessment

 • CSD Policies

 • Secure Desktop (Vault)

 • Cache Cleaner

 • Keystroke Logger Detection

 • Host Emulation Detection
1-1
Secure Desktop Configuration Guide



 

Chapter 1      Introduction
Features
Integration with Dynamic Access Policies
The security appliance integrates the CSD features into dynamic access policies (DAPs). Depending on 
the configuration, the security appliance uses one or more endpoint attribute values in combination with 
optional, AAA attribute values as conditions for assigning a DAP. The CSD features supported by the 
endpoint attributes of DAPs include OS detection, CSD policies, Basic Host Scan results, and Endpoint 
Assessment. (The sections that follow describe these features.)

As an administrator, you can specify a single attribute or combine attributes that together form the 
conditions required to assign a DAP to a session. The DAP provides network access at the level that is 
appropriate for the endpoint AAA attribute value. The security appliance applies a DAP when all of its 
configured endpoint criteria are satisfied.

Host Scan
Host Scan is a module that installs on the remote device after the user connects to the security appliance, 
before the user logs in. Host Scan consists of any combination of the following modules (Basic Host 
Scan, Endpoint Assessment, and advanced Endpoint Assessment), as configured by the CSD 
administrator. Host Scan runs on Microsoft Windows, Apple Mac OS, and Linux. For detailed 
requirements, see the Cisco Secure Desktop Release Notes.

Basic Host Scan

Basic Host Scan automatically identifies operating systems and service packs on connecting computers. 
It also lets you configure inspections for specified processes, files, and registry keys. Thus, you can use 
this feature to configure checks for watermarks on remote computers to determine whether they are 
corporate-owned. You can use the results to be returned by Basic Host Scan when configuring different 
DAPs to distinguish corporate computers, home computers, and public computers.

Basic Host Scan attempts to run on any remote device establishing a Cisco clientless SSL VPN or 
AnyConnect Client session, if CSD is enabled on the security appliance. The OS detection automatically 
qualifies or disqualifies the remote device from running Endpoint Assessment, Advanced Endpoint 
Assessment, Secure Desktop (Vault), and Cache Cleaner, whichever is configured to run. Process name, 
filename, and registry key checking to be performed by Basic Host Scan must be explicitly configured 
using Secure Desktop Manager. Basic Host Scan returns the name of the OS and service pack, and the 
results of any configured checks to the security appliance. 

The security appliance evaluates the returned values against the endpoint criteria explicitly configured 
into the DAPs. Thus, you can assign DAPs to devices based on this data. To view the list of the operating 
systems and service packs this module detects, choose Configuration > Remote Access VPN > 
Network (Client) Access or Clientless SSL VPN Access > Dynamic Access Policies > Add or Edit, 
Add or Edit next to the endpoint attributes table, select Operating System from the Endpoint Attribute 
Type drop-down list, check OS Version, and click the arrow to the right of the adjacent operator.

Basic Host Scan automatically returns the following additional values for evaluation against configured 
DAP endpoint criteria:

 • Microsoft Windows, Mac OS, and Linux builds

 • Listening ports active on a connecting host running Microsoft Windows

 • CSD components installed on the connecting host

 • Microsoft Knowledge Base numbers (KBs) 
1-2
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Features
If you want to configure endpoint criteria to match other data, enter the appropriate free-form Lua text 
into the Advanced Logical Expressions text box. Be aware that doing so requires sophisticated 
knowledge of Lua. For more information, open the Add or Edit Dynamic Access Policies window, click 
Advanced at the bottom of the Selection Criteria area, and click the Guide button to the right of the 
Logical Expressions text box.

Endpoint Assessment

Endpoint Assessment, a Host Scan extension, examines the remote computer for a large collection of 
antivirus and antispyware applications, associated definitions updates, and firewalls. You can use this 
feature to combine endpoint criteria to satisfy your requirements before the security appliance assigns a 
specific DAP to the session.

Advanced Endpoint Assessment

Advanced Endpoint Assessment, another Host Scan extension, lets you configure an attempt to update 
noncompliant computers. For example, you can use this feature to attempt to force updates of a specific 
antivirus application version and its antivirus definitions file. 

Note This feature requires an Advanced Endpoint Assessment license.

Prelogin Assessment
The prelogin assessment module also installs itself after the user connects to the security appliance, but 
before the user logs in. This module can check the remote device for files, digital certificates, the OS, 
IP address, and Microsoft Windows registry keys.

Secure Desktop Manager, the administrator interface to CSD, provides a graphical sequence editor to 
simplify the configuration of the prelogin assessment module.

When configuring the prelogin assessment module, the CSD administrator creates branches of nodes 
called sequences. Each sequence begins with the Start node, followed by an endpoint check. The result 
of the check determines whether to perform another endpoint check or to terminate the sequence with 
an end node. 

The end node determines whether to display a Login Denied message, assign a CSD policy to the device, 
or perform a secondary set of checks called a subsequence. A subsequence is a continuation of a 
sequence, typically consisting of more endpoint checks and an end node. This feature is useful to do the 
following:

 • Reuse a sequence of checks in some cases but not others.

 • Create a set of conditions that have an overall purpose that you want to document by using the 
subsequence name.

 • Limit the horizontal space occupied by the graphical sequence editor.
1-3
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CSD Policies
CSD policies let you determine how remote devices connect to your virtual private network, and protect 
them accordingly. These policies specify the remote user experience, rights, and restrictions. You create 
these policies when you configure the prelogin assessment module. The results of the checks in the 
graphical sequence editor determine whether the prelogin assessment results in the assignment of a 
particular prelogin policy or in a denial.

As you create each policy, Secure Desktop Manager adds a menu named after the policy. Each of the 
policy menus let you assign unique settings to the policy. These settings determine whether the Secure 
Desktop (Vault) module, Cache Cleaner module, or neither module installs on remote devices that match 
the prelogin criteria assigned to the policy. Administrators typically assign these modules to 
noncorporate computers to prevent access to corporate data and files after the session is over. The 
sections that follow provide more information about the Secure Desktop and Cache Cleaner modules.

You might choose to assign neither Secure Desktop nor Cache Cleaner to the policy if the remote device 
is a corporate computer. For example, computers connecting from within a workplace LAN on a 10.x.x.x 
network are an unlikely risk for exposing confidential information. For these computers, you might set 
up prelogin policy named Secure to match the IP addresses on the 10.x.x.x network, and disable Secure 
Desktop and Cache Cleaner on that policy.

In contrast, users’ home computers might be considered more at risk to viruses because of their mixed 
use. For these computers, you might set up a prelogin policy named home for employees’ home 
computers on which they have installed a corporate-supplied certificate. DAP criteria that includes this 
prelogin policy should also require the presence of antivirus and antispyware software to grant full 
access to the network.

Finally, for untrusted locations such as Internet cafes, you might set up a prelogin policy named “Public” 
that has either no matching criteria, thus making it the default policy for remote access devices that do 
not meet the requirements of more secure policies; or you might define criteria that are less stringent. 
This prelogin policy would require a Secure Desktop installation, and include a short timeout period to 
prevent access by unauthorized users.

Secure Desktop (Vault)
Secure Desktop, encrypts the data and files associated with or downloaded during the remote session 
into a secure desktop partition, and presents a graphical representation of a desktop that includes an 
image of a lock to signify a safe environment for the remote user to work in. Upon session termination, 
it uses a U.S. Department of Defense (DoD) sanitation algorithm to remove the partition.

Typically used during clientless SSL VPN sessions, Secure Desktop attempts to reduce the possibility 
that cookies, browser history, temporary files, and downloaded content remain after a remote user logs 
out, the session times out, or after an abrupt termination occurs.

As an administrator, you can control Secure Desktop access to the registry, command window, network 
drives and folders, and removable drives.

Secure Desktop runs only on 32-bit Microsoft Windows OS’s. For detailed requirements, see the Cisco 
Secure Desktop Release Notes. If a prelogin policy is configured to install Secure Desktop, but the 
operating system on the remote computer does not support it, Cache Cleaner attempts to install instead.

Browser plug-ins, shell extensions, and a cluttered registry can greatly extend the time needed for Secure 
Desktop to perform the read and write operations on the registry. Secure Desktop performs registry 
operations to do the filtering necessary to perform its tasks. It can therefore take a longer period of time 
than one would expect for the clientless SSL VPN login page to open Secure Desktop if the remote 
computer is slow or is cluttered.
1-4
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Only the Documents and Settings, WINDOWS and Program Files directory on Microsoft Windows are 
visible from the Secure Desktop (Vault). For optimum security, only applications installed under in these 
directories are accessible under Secure Desktop. It does not support or allow access to applications not 
found in these default installation locations.

Secure Desktop does not encrypt or clean system memory information, including that which may be left 
on the disk by the operating system in the Microsoft Windows virtual memory file, commonly referred 
to as the paging file. Secure Desktop Manager provides an option that seeks to disable printing from 
within a user session. If local printing is permitted, there may be instances when data can remain in the 
local system print spool.

Cache Cleaner
Cache Cleaner, an alternative to Secure Desktop, is functionally more limited, but has the flexibility to 
support more operating systems. It attempts to eliminate the information from the browser cache at the 
end of a clientless SSL VPN or AnyConnect Client session. This information includes entered 
passwords, auto-completed text, files cached by the browser, and browser configuration changes made 
during the session.

Cache Cleaner runs on Microsoft Windows, Apple Mac OS, and Linux. For detailed requirements, see 
the Cisco Secure Desktop Release Notes.

Keystroke Logger Detection
You can configure selected prelogin policies to scan for processes or modules that record keystrokes 
entered by the user, and deny VPN access if a suspected keystroke logging application is present.

By default, keystroke logger detection is disabled for each prelogin policy. You can use Secure Desktop 
Manager to enable or disable keystroke logger detection. You can specify the keystroke loggers that are 
safe or let the remote user interactively approve the ones that the scan identifies as a condition for 
running Secure Desktop, Cache Cleaner, or Host Scan on the remote computer.

If you enable it, it downloads with Secure Desktop, Cache Cleaner, or Host Scan onto the remote 
computer. Following the download, keystroke logger detection runs only if the OS is Windows and the 
user login has administrator privileges.

The associated module runs only if the scan is clear, or only if you assign administrative control to the 
user and the user approves of the applications the scan identifies.

Note Keystroke logger detection applies to both user mode and kernel mode loggers as long as the end-user 
is logged in with administrator privileges.

Keystroke logger detection runs only on 32-bit Microsoft Windows OS’s. It runs on the same OS’s as 
Secure Desktop (Vault). 

Keystroke logger detection may be unable to detect every potentially malicious keystroke logger. It does 
not detect hardware keystroke logging devices.
1-5
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Host Emulation Detection
Host emulation detection, another feature of prelogin policies, determines whether a remote Microsoft 
Windows operating system is running over virtualization software. You can use Secure Desktop Manager 
to enable or disable this feature, and deny access if a host emulator is present or report the detection to 
the user and let the user decide whether to continue or terminate.

By default, host emulation detection is disabled for each prelogin policy. If you enable it, it downloads 
with Secure Desktop, Cache Cleaner, or Host Scan onto the remote computer. Following the download, 
host emulation detection runs first, along with keystroke logger detection if it is configured to do so. The 
associated module then runs if either of the following conditions are true:

 • The host is not running over an emulator (or virtualization software).

 • You did not configure it to always deny access, and the user approves of the detected host emulator.

Host emulation detection runs only on 32-bit Microsoft Windows OS’s. It runs on the same OS’s as 
Secure Desktop (Vault).

CSD Workflow
When fully configured, CSD works with the security appliance to protect the corporate network as 
follows:

Step 1 The remote device attempts to establish a clientless SSL VPN or AnyConnect Client session with the 
security appliance.

Note Each of the “modules” identified in this section are features of CSD.

Step 2 A prelogin assessment module checks for the following on the remote device:

 • OS.

 • Presence or absence of any files you (the CSD administrator) specify.

 • Presence or absence of any registry keys you specify. This check applies only if the computer is 
running Microsoft Windows.

 • Presence of any digital certificates you specify. This check also applies only if the computer is 
running Microsoft Windows.

 • IP address within a range you specify.

Step 3 One of the following events occurs, depending on the result of the previous step:

 • The Login Denied message appears if the remote computer runs the prelogin assessment and 
traverses a sequence that ends with a Login Denied end node. In this case, interaction between the 
security appliance and the remote device stops.

 • The prelogin assessment module assigns a prelogin policy name to the device and reports the name 
of the prelogin policy to the security appliance.

Step 4 Host Scan downloads and runs with Secure Desktop, Cache Cleaner, or neither, depending on whether 
one of these modules is enabled on the prelogin policy assigned to the remote device. If Secure Desktop 
is enabled but it cannot run on the operating system detected, only Cache Cleaner runs.

Step 5 The user logs in.
1-6
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Step 6 The security appliance typically uses the authentication data along with any configured endpoint 
attribute criteria, which can include such values as the prelogin policy and Host Scan results, to apply a 
DAP to the session.

Step 7 Following the termination of the user session, Host Scan terminates, and Cache Cleaner or Secure 
Desktop performs its cleanup functions.

Management Interface
The management interface called Secure Desktop Manager lets you configure CSD on the security 
appliance. After installing and enabling CSD, choose Configuration > Remote Access VPN > Secure 
Desktop Manager.

The Secure Desktop Manager pane opens. When CSD is disabled, only the Setup menu option is present. 
This option lets you enable CSD. When you install and enable Secure Desktop, exit ASDM, and 
establish a new ASDM connection, Secure Desktop Manager displays the full menu. Figure 1-1 shows 
the Secure Desktop Manager pane and the fully-expanded, default menu.

Figure 1-1 Secure Desktop Manager (Initial)
1-7
Cisco Secure Desktop Configuration Guide

 



 

Chapter 1      Introduction
Management Interface
The following options are present in the Secure Desktop Manager menu:

 • Setup—Lets you retrieve a CSD image from your computer and install the image, replace and install 
the existing image with a newer or older one, uninstall the image, and enable or disable CSD.

 • Global Settings—Lets you change the level of CSD logging that occurs on VPN user endpoints 
when users connect to the security appliance.

 • Prelogin Policy — Lets you view or configure the prelogin assessment of computers connecting to 
the security appliance, and add, view, rename, or remove prelogin policies to be applied to remote 
computers that pass prelogin assessment criteria.

Use the Prelogin Policy option to specify the conditions the remote computer must satisfy to qualify 
for a prelogin policy assignment. For example, you can assign a prelogin policy named “Secure” to 
remote computers with DHCP-assigned IP addresses within the corporate address range.

 • Secure Desktop Customization—Lets you rebrand and customize the Secure Desktop windows 
displayed to remote users, including the Secure Desktop background (the lock icon) and its text 
color, and the dialog banners for the Desktop, Cache Cleaner, Keystroke Logger, and Close Secure 
Desktop windows.

 • Default—By default, the prelogin policy diagram displayed by the graphical sequence editor has 
only one prelogin policy. Its name is Default. Secure Desktop Manager adds a menu to the left for 
every prelogin policy named in the Prelogin Policy diagram. You can view and change the settings 
assigned to the prelogin policy by clicking its name in the menu or clicking its subordinate options.

When you add a prelogin policy to the configuration, Secure Desktop Manager displays the name of 
the policy in the menu, along with the following options for configuring privileges and restrictions 
for that policy:

 – Keystroke Logger & Safety Checks—Enables and disables scans of the remote PC for keystroke 
logging applications and a host emulator.

 – Cache Cleaner — Click to refine the Cache Cleaner settings if Secure Desktop or Cache Cleaner 
on the parent menu is checked. This option now supports Microsoft Windows Vista, Windows 
XP, and Windows 2000; Apple Macintosh OS X 10.4 (PowerPC or Intel); and Linux.

 – Secure Desktop (Vault) General—Lets you specify Secure Desktop (Vault) settings if it is 
enabled.

 – Secure Desktop (Vault) Settings—Lets you place restrictions on Secure Desktop if it is enabled.

 – Secure Desktop (Vault) Browser—Lets you specify the default home page for the browser. This 
option also lets you specify folders and bookmarks (or “favorites”) to insert into the respective 
browser menu during the session.

 • Host Scan—Click to specify files, processes, and Microsoft Windows registry keys to scan for after 
completing the prelogin assessment. The scan for these items is called a Basic Host Scan. You can 
also click Host Scan to enable Endpoint Assessment, a scan for antivirus, personal firewall, and 
antispyware applications and updates that are running on the remote computer. Finally, you can click 
Host Scan to configure an Advanced Endpoint Assessment, which updates the specified applications 
and updates on noncompliant computers. This latter feature requires you to have an Advanced 
Endpoint Assessment license.

Following the configuration of the prelogin policies and host scan options, you can configure a match of 
any one or any combination of the following Host Scan results to assign a dynamic access policy 
following the user login:

 • operating system

 • (prelogin) policy

 • registry key (Microsoft Windows only)
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 • file

 • process

 • antivirus application

 • personal firewall application

 • antispyware application

Saving and Resetting the Running Configuration
Secure Desktop Manager saves all CSD configuration data to disk0:/sdesktop/data.xml.

Note To copy the configuration settings from one security appliance to another, transfer a copy of the 
disk0:/sdesktop/data.xml file to the flash device of the target security appliance. Disable and reenable 
Cisco Secure Desktop to copy the disk0:/sdesktop/data.xml file into the running configuration.

The security appliance stores the settings displayed in the Secure Desktop Manager > Setup pane. Secure 
Desktop Manager stores the remaining settings in the disk0:/sdesktop/data.xml file. Secure Desktop 
Manager displays two buttons at the bottom of the panes beginning with Secure Desktop Manager > 
Prelogin Policy for interacting with that file. Use these buttons as follows:

 • To save the running CSD configuration to the data.xml file, click Apply All.

 • To remove all unapplied changes from this Secure Desktop Manager session, click Reset All.

An “Unapplied Changes” dialog box prompts you to save the CSD configuration if you try to navigate 
away from it or exit without having saved the configuration. Clicking Apply Changes in that window is 
equivalent to clicking the Apply All button.
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Installing and Enabling CSD

This chapter describes how to perform the following tasks on the security appliance.

 • Verifying Installation or Upgrade Requirements

 • Installing or Upgrading CSD

 • Enabling or Disabling CSD

 • Entering an Activation Key to Support Advanced Endpoint Assessment

 • Configuring CSA Interoperability with the AnyConnect Client and CSD

 • Uninstalling CSD

Verifying Installation or Upgrade Requirements
CSD 3.4.1 requires the following:

 • ASA Release 8.0(4) or later

 • ASDM 6.1(3) or later

If you are upgrading, CSD 3.3 or 3.4 must be installed.

Installing or Upgrading CSD
You do not need to restart the security appliance after you install or upgrade CSD, however, you must 
exit and restart your ASDM connection to access Secure Desktop Manager.

Install or upgrade the CSD software on the security appliance as follows:

Step 1 Use your Internet browser to access the following URL and download the csd_<n>.<n>.*.pkg file to 
“My Documents” on your PC:

http://www.cisco.com/cgi-bin/tablebuild.pl/securedesktop

Step 2 Establish an ASDM session with the security appliance.

Step 3 Choose Configuration > Remote Access VPN > Secure Desktop Manager > Setup.

ASDM opens the Setup pane (Figure 2-1).
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Figure 2-1 Setup

Step 4 Click Upload to prepare to transfer a copy of the CSD software from your local PC to the flash card 
installed in the ASA 5500.

ASDM opens the Upload Image dialog box.

Step 5 Click Browse Local to prepare to select the file on your local PC.

By default, the Selected File Path dialog box displays the contents of the My Documents folder.

Step 6 Choose the csd_<n>.<n>.*.pkg you downloaded in Step 1 and click Select.

ASDM closes the Select File Path dialog box.

Step 7 Click Browse Flash and enter the name of the csd_<n>.<n>.*.pkg file you are uploading in the File 
Name field, then click OK.

Step 8 Click Upload File.

Caution Avoid opening other windows until you complete the remaining steps.

ASDM transfers a copy of the file to the flash card. An Information dialog box displays the following 
message:

File has been uploaded to flash successfully.

Step 9 Click OK.

ASDM clears the fields in the Upload Image dialog box.

Step 10 Click Close.

The Use Uploaded Image dialog box displays the following message:

Use disk0:/csd_<n>.<n>.*.pkg as your new current image?

Step 11 Click OK.

Step 12 Check Enable Secure Desktop if it is not already checked.
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Step 13 Click Apply.

The Uninstall CSD dialog box opens if you upgraded from an earlier version of CSD, and displays the 
following message:

Do you want to delete disk0:<Previous_Version>.pkg?

Step 14 Click Yes to remove the previous version from the flash memory card, and click Proceed in the Refresh 
Needed window.

If you choose to downgrade later, you can use the same method you used to upgrade (that is, upload and 
install it).

An ASDM Restart Confirmation window displays the following message:

The Secure Desktop image is successfully updated. The new features can be accessed after 
ASDM is restarted.

Step 15 Click OK.

Step 16 The Secure Desktop Manager menu closes.

If you reopen the menu, it shows only the Setup option.

Step 17 Click the X in the upper right corner of the ASDM window to exit.

A window displays the following message:

The configuration has been modified. Do you want to save the running configuration to 
flash memory?

Step 18 Click Save.

ASDM saves the configuration and closes.

Step 19 Establish a new ASDM session with the security appliance to customize the Secure Desktop Manager 
configuration.

Enabling or Disabling CSD
Enabling CSD loads the CSD configuration file, data.xml, from the flash device to the running 
configuration. If you transfer or replace the data.xml, disable and then enable CSD to load the file.

Disabling CSD does not alter the CSD configuration.

Use ASDM to enable or disable CSD as follows:

Step 1 Choose Configuration > Clientless SSL VPN > Secure Desktop > Setup.

ASDM opens the Setup pane (Figure 2-1).

Note The Secure Desktop Image field displays the image (and version) that is currently installed. The 
Enable Secure Desktop check box indicates whether CSD is enabled.

Step 2 Check or uncheck Enable Secure Desktop and click Apply.

ASDM enables or disables CSD.
2-3
Cisco Secure Desktop Configuration Guide

 



 

Chapter 2      Installing and Enabling CSD
Entering an Activation Key to Support Advanced Endpoint Assessment
Entering an Activation Key to Support Advanced Endpoint 
Assessment

Advanced Endpoint Assessment includes all of the Endpoint Assessment features, and lets you configure 
an attempt to update noncompliant computers to meet version requirements. You can use ASDM to 
activate a key to support Advanced Endpoint Assessment after acquiring it from Cisco, as follows:

Step 1 Choose Device Management > System Image/Configuration > Activation Key.

Step 2 Enter the key in the New Activation Key field.

Step 3 Click Update Activation Key.

Step 4 Choose File > Save Running Configuration to Flash.

An Advanced Endpoint Assessment entry appears and the Configure button becomes active in the Host 
Scan Extensions area of the Configuration > Remote Access VPN > Secure Desktop Manager > Host 
Scan pane, which is accessible only if CSD is enabled.

Configuring CSA Interoperability with the AnyConnect Client 
and CSD

If your remote users have Cisco Security Agent (CSA) installed, you must import new CSA policies to 
the remote users to enable the AnyConnect VPN Client and CSD to interoperate with the security 
appliance.

To do this, follow these steps:

Step 1 Retrieve the CSA policies for the AnyConnect client and CSD. You can get the files from:

 • The CD shipped with the security appliance.

 • The software download page for the ASA 5500 Series Adaptive Security Appliance at 
http://www.cisco.com/cgi-bin/tablebuild.pl/asa.

The filenames are AnyConnect-CSA.zip and CSD-for-CSA-updates.zip

Step 2 Extract the .export files from the .zip package files.

Step 3 Choose the correct version of the .export file to import. The Version 5.2 export files work for CSA 
Versions 5.2 and higher. The 5.x export files are for CSA Versions 5.0 and 5.1.

Step 4 Import the file using the Maintenance > Export/Import tab on the CSA Management Center.

Step 5 Attach the new rule module to your VPN policy and generate rules.

For more information, see the CSA document Using Management Center for Cisco Security Agents 5.2. 
Specific information about exporting policies is located in the section Exporting and Importing 
Configurations.
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Uninstalling CSD
Uninstalling CSD removes the CSD configuration file, data.xml, from the sdesktop directory on the flash 
card. If you want to retain the file, copy it using an alternative name or download it to your workstation 
before you uninstall CSD.

Uninstall CSD on the security appliance as follows:

Step 1 Establish an ASDM session with the security appliance.

Step 2 Choose Configuration > Remote Access VPN > Secure Desktop Manager > Setup.

ASDM opens the Setup pane (Figure 2-1).

Step 3 Click Uninstall.

A confirmation window displays the following message:

Do you want to delete disk0:/csd_<n>.<n>.*.pkg and all CSD data files?

Step 4 Click Yes.

ASDM removes the text from the Location text box and removes the Secure Desktop Manager menu 
options below Setup.
2-5
Cisco Secure Desktop Configuration Guide

 



 

Chapter 2      Installing and Enabling CSD
Uninstalling CSD
2-6
Cisco Secure Desktop Configuration Guide



 

Cis
 

C H A P T E R 3

Configuring Host Scan

The following sections describe how to configure Host Scan:

 • Using Host Scan without Secure Desktop and Cache Cleaner

 • Scanning for Registry Keys, Files, and Processes

 • Enabling and Disabling Scanning for Antivirus, Personal Firewall, and Antispyware Applications

 • Configuring Antivirus, Personal Firewall, and Antispyware Remediation

Using Host Scan without Secure Desktop and Cache Cleaner
If you want to run Host Scan on connecting computers, but do not want Secure Desktop and Cache 
Cleaner to run, follow these steps:

Step 1 Click the name of the CSD policy in the Secure Desktop Manager window and uncheck Secure Desktop 
and Cache Cleaner. (The name of the default policy is “Default,” so if you have not used Secure Desktop 
Manager to create any policies, click Default in the Secure Desktop Manager menu, then uncheck 
Secure Desktop and Cache Cleaner.

Step 2 Use the sections below to configure Host Scan.

Step 3 Follow the instructions in Using Match Criteria to Configure Dynamic Access Policies to select optional 
registry entry, filename, and process name criteria accessed from the Basic Host Scan table and to 
specify antivirus, antispyware, and personal firewall application requirements as criteria for applying 
endpoint policies.

Scanning for Registry Keys, Files, and Processes
You can specify a set of registry entries, filenames, and process names, which form a part of Basic Host 
Scan. Host Scan, which includes Basic Host Scan and Endpoint Assessment, or Advanced Endpoint 
Assessment; occurs after the prelogin assessment but before the assignment of a DAP. Following the 
Basic Host Scan, the security appliance uses the login credentials, the host scan results, prelogin policy, 
and other criteria you configure to assign a DAP.

See the sections that name the types of Basic Host Scan entries you would like to configure:

 • Adding a File Check
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 • Adding a Registry Key Check

 • Adding a Process Check

Adding a File Check
You can check for a file on an endpoint running Microsoft Windows, Mac OS, or Linux.

To add a check for a specific file to the Basic Host Scan, follow these steps:

Step 1 Choose Secure Desktop Manager > Host Scan.

The Host Scan pane opens (Figure 3-1).
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Figure 3-1 Host Scan

Note Regardless of whether you have an Advanced Endpoint Assessment license, you can use ASDM 
to configure Dynamic Access Policies for making policy decisions based on the scan results. 

Step 2 Click Add > File Scan.

The Add File Scan pane opens (Figure 3-2).
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Figure 3-2 Add File Scan

Step 3 Assign values to the following attributes:

 • Endpoint ID—Enter a unique and meaningful string to serve as an index to this entry. After 
completing the Host Scan configuration, specify the same index when you assign this entry as an 
endpoint attribute when configuring a DAP. The string is case-sensitive.

For example,

File-okclient.exe

 • File Path—Enter the directory path to the file.

Secure Desktop Manager retains the case of the text you enter to check for a path to a file on the 
remote device. The match results are case-sensitive only if the devices are running Linux or MacOS. 
The Microsoft Windows file system is not case-sensitive.

For example,

C:\Program Files\Cisco Systems\CSAgent\bin\okclient.exe

Step 4 Click OK.

ASDM closes the Add File Scan window and inserts the entry into the Basic Host Scan table.

Adding a Registry Key Check
Registry key scans apply only to computers running Microsoft Windows operating systems. Basic Host 
Scan ignores registry key scans if the computer is running Mac OS or Linux. 

Add a check for a specific registry key to Basic Host Scan as follows:

Step 1 Choose Secure Desktop Manager > Host Scan.

The Host Scan pane opens (Figure 3-1).

Step 2 Click Add > Registry Scan.

The Add Registry Scan pane opens (Figure 3-3).
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Figure 3-3 Add Registry Scan

Step 3 Assign values to the following attributes:

 • Endpoint ID—Enter a unique and meaningful string to serve as an index to this entry. After 
completing the Host Scan configuration, specify the same index when you assign this entry as an 
endpoint attribute when configuring a DAP. The string is case-sensitive.

For example,

Registry-SecureDesktop

 • Entry Path menu—Choose the hive, the initial directory path to the registry key. The options are as 
follows:

HKEY_CLASSES_ROOT\
HKEY_CURRENT_USER\
HKEY_LOCAL_MACHINE\
HKEY_USERS\

Each string references a registry base that stores different information. The HKEY_LOCAL_MACHINE\ 
path is the most commonly used one because it contains the machine-specific registry files.

 • Entry Path field—Enter the name of the registry key.

Caution Do not type quotes in a Registry Key name that includes spaces.

For example,

SOFTWARE\CISCO SYSTEMS\SECURE DESKTOP\(Default)

Step 4 Click OK.

ASDM closes the Add Registry Scan window and inserts the entry into the Basic Host Scan table.

Adding a Process Check
You can check for a process running on Microsoft Windows, Mac OS, or Linux. 

To add a check for a specific process to Basic Host Scan, follow these steps:

Step 1 Choose Secure Desktop Manager > Host Scan.

The Host Scan pane opens (Figure 3-1).
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Step 2 Click Add > Process Scan.

The Add Process Scan pane opens (Figure 3-4).

Figure 3-4 Add Process Scan

Step 3 Assign values to the following attributes:

 • Endpoint ID—Enter a unique and meaningful string to serve as an index to this entry. After 
completing the Host Scan configuration, specify the same index when you assign this entry as an 
endpoint attribute when configuring a DAP. The string is case-sensitive.

For example,

Process-Agent.exe

 • Process Name—Enter the name of the process. You can display it in Microsoft Windows by opening 
the Windows Task Manager window and clicking the Processes tab.

For example,

Agent.exe

Step 4 Click OK.

ASDM closes the Add Process Scan window and inserts the entry into the Basic Host Scan table.

Enabling and Disabling Scanning for Antivirus, Personal 
Firewall, and Antispyware Applications

You can configure a scan for antivirus, personal firewall, and antispyware applications and updates as a 
condition for the completion of a Cisco AnyConnect or clientless SSL VPN connection. Following the 
prelogin assessment, CSD loads Endpoint Assessment checks and reports the results back to the security 
appliance for use in assigning a DAP.

To enable or disable Host Scan Extensions,

Step 1 Choose Secure Desktop Manager > Host Scan.

The Host Scan window opens (Figure 3-1).

Step 2 Check one of the following options in the Host Extensions area of the Host Scan window:

 • Endpoint Assessment—If you check this option the remote PC scans for a large collection of 
antivirus, antispyware, and personal firewall applications, and associated updates.
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 • Advanced Endpoint Assessment—This option is present only if the configuration includes a key 
for an Advanced Endpoint Assessment license. It includes all of the Endpoint Assessment features, 
and lets you configure an attempt to update noncompliant PCs to meet the version requirements you 
specify. To turn on this option after acquiring a key from Cisco, choose Configuration > Device 
Management > System Image/Configuration > Activation Key, enter the key in the New 
Activation Key field, and click Update Activation Key.

When you check this option, Secure Desktop Manager inserts a check mark next to both options.

To disable the host scan extensions, uncheck both options in the Host Extensions area of the Host Scan 
window.

Configuring Antivirus, Personal Firewall, and Antispyware 
Remediation

Advanced Endpoint Assessment lets you configure an attempt to update noncompliant computers to 
meet the version requirements you specify. If you configure remediation of antivirus and antispyware 
versions, associated definitions updates, and personal firewall versions, Host Scan attempts to update 
them if they are not present.

To configure Advanced Endpoint Assessment,

Step 1 Choose Secure Desktop Manager > Host Scan.

The Host Scan window opens (Figure 3-1).

Step 2 Check or click Advanced Endpoint Assessment.

Secure Desktop Manager activates the Configure button if the security appliance configuration has an 
Advanced Endpoint Assessment license. Otherwise, you need to get an Advanced Endpoint Assessment 
license to configure remediation. After doing so, choose Configuration > Device Management > 
System Image/Configuration > Activation Key, enter the key in the New Activation Key field, and 
click Update Activation Key. Then return to this step.

Step 3 Click Configure.

The Windows, Mac OS, and Linux tabs let you specify remediation for each respective operating system. 
The three tabs are the same; only the vendors and applications differ. By default, Host Scan does not 
attempt to remediate. Figure 3-5 shows the default Windows tab.
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Figure 3-5 Advanced Endpoint Assessment (Windows Tab Example)

Note Secure Desktop Manager activates attributes and buttons in response to a selection only if the 
application supports the attributes and button functions. For example, you can click Add to add 
a personal firewall rule only if the selected personal firewall application supports rules. 

Step 4 Click Add next to the Antivirus table, select one or more Vendor-Product options from the dialog box, 
and click OK.

Secure Desktop Manager inserts the options you selected into the antivirus table.
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Step 5 Set the following optional antivirus attributes:

 • Force File System Protection—(Enabled only if the selected antivirus application supports this 
feature) Check if you want to turn on ongoing background scanning by the installed antivirus 
application. The application checks files as they are received and blocks access to files that are likely 
to contain viruses.

 • Force Virus Definitions Update—Check to require the remote host to check for a virus definitions 
update for the installed application. If you check this option, you must specify the number of days.

 • if not updated in last— Enter the age in days of the last update that triggers a new update.

Step 6 Click Add next to the Personal Firewall table, select one or more Vendor-Product options from the dialog 
box, and click OK.

Step 7 Configure the optional Personal Firewall action and rules, as follows:

Caution Any action and rules you configure persist on the end-user device even after the VPN session 
ends. Please apply them with discretion.

 • Firewall Action—The contents of this drop-down list depend on the options available for the 
selected personal firewall. Select None, Force Enable to enable the firewall, or Force Disable to 
disable the firewall.

 • Rules—This table is available only if the selected personal firewall supports rules. It lets you specify 
applications and ports for which the firewall allows or blocks ports or applications. See 
“Configuring Personal Firewall Rules” for instructions.

Step 8 Click Add next to the Antispyware table, select one or more Vendor-Product options from the dialog 
box, and click OK.

Step 9 Set the following optional antispyware attributes:

 • Force Spyware Definitions Update—Check to require the remote host to check for a spyware 
definitions update for the selected application. If you check this option, you must specify the number 
of days.

 • if not updated in last— Enter the age in days of the last update that triggers a new update.

Step 10 Click OK.

Configuring Personal Firewall Rules

Personal firewall rules let you specify applications and ports for the firewall to allow or block. The Add, 
Edit, and Delete buttons next to the Rules table in the Advanced Endpoint Assessment window 
(Figure 3-5) are active only if the selected personal firewall supports rules. For example, the applications 
that appear under the Internet Security Systems, Inc. options support personal firewall rules.

If you configure Advance Endpoint Assessment as described in the previous section and click Add or 
Edit next to the Rules table, the Add or Edit Rule window opens (Figure 3-6).
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Figure 3-6 Add Personal Firewall Rule

To set the attributes in the Add or Edit Rule window,

Step 1 Use the following attribute description to select the rule.

Rule—Choose the action of this rule. The options are ALLOW Application, BLOCK Application, 
ALLOW Port, and Block Port.

Step 2 Go to the Application area and set the following attributes if you selected ALLOW Application or 
BLOCK Application.

Name—Enter the full file name and extension of the application to be allowed or blocked.

Full path—Enter the entire path to the application file.

Step 3 Go to the Port area and set the following attributes if you selected ALLOW Port or BLOCK Port.

Protocol—Select the protocols to be allowed or blocked. The options are Any, UDP, and TCP.

Port—Enter the port number to be allowed or blocked.

Step 4 Click OK.

Repeat this procedure for each personal firewall rule you want to configure.
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Tutorial: Assigning Prelogin Criteria to Policies

This tutorial provides an overview of the CSD configuration sequence. The configuration chapters that 
follow provide detailed instructions on the attributes. The sections are as follows:

 • Overview

 • Configuring a Prelogin Assessment

 • Configuring Secure Desktop and Cache Cleaner

 • Assigning a DAP for Each Endpoint Profile

Overview
This tutorial describes how to configure three example prelogin policies: “Secure,” “Home,” and 
“Public.” “Secure” is for those connecting to the VPN from a workstation in the office, “Home” is for 
those working from home, and “Public” is for those who do not meet the criteria for either, such as those 
connecting from a cybercafé.

Note This tutorial is only an example; we recommend that you choose profile names and configuration 
settings in your actual deployment that reflect your VPN security policies.

In this tutorial, “Secure” provides clients with full access, “Home” provides some flexibility, and 
“Public” requires restricts access. This tutorial defines the prelogin policies as follows: 

 • Secure

 – Assign a prelogin assessment to recognize a corporate computer attempting to establish a VPN 
connection by verifying the OS is Microsoft Windows, that the IP address is within a specified 
range, and that the computer has a specified registry entry.

 – Disable Secure Desktop (Vault) and Cache Cleaner.

 – Use the dynamic access policy (DAP) configuration to assign access rights.

 • Home

 – Identify using a certificate given by the administrator and a file check.

 – Enable Secure Desktop and Vault Reuse with no timeout.
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Vault Reuse lets users close Secure Desktop and open it again at a later time. It becomes a 
persistent desktop that is available from one session to the next. If you enable this option, users 
must enter a password (up to 127 characters in length) before the establishment of a Secure 
Desktop session. 

 – Advanced features require company antivirus software, antispyware, and a software firewall.

 – Check for keystroke logger.

 – Use the DAP configuration to assign access rights.

 • Public profile

 – Check for malware file.

 – Check for keystroke logger file.

 – Install Cache Cleaner.

 – Use the DAP configuration to assign access rights.

Our example includes “Secure,” “Home,” and “Public” in that order; to assign privileges to a host, CSD 
first determines whether it is a “Secure” host. If it is not, it determines whether it is a “Home” host. If it 
is not, it performs several file checks and assigns the privileges associated with the “Public” endpoint 
profile.

Configuring a Prelogin Assessment
These instructions assume that Secure Desktop Manager has loaded the default configuration. To reload 
the default configuration, rename the sdesktop/data.xml file, disable CSD, re-enable it, exit ASDM, then 
start a new ASDM session.

Use the following sections to configure the prelogin assessment and assign names to the prelogin 
policies:

 • Configuring Prelogin Criteria for a Secure Computer

 • Configuring Prelogin Criteria for a Home Computer

 • Configuring Prelogin Criteria for a Public Computer

Configuring Prelogin Criteria for a Secure Computer
Use the following instructions to specify criteria for a CSD policy for secure computers attempting VPN 
connections:

Step 1 Choose Prelogin Policy.

The Prelogin Policy pane shows the default endpoint profile named “Default.” The menu shows the same 
profile name, indicating the place where you assign settings to that profile (Figure 4-1).
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Figure 4-1 Duplication of the Default Prelogin Policy Name in the Menu

Tip If you would like to explore the options available in the prelogin assessment sequence editor 
without making permanent changes to the CSD configuration file, data.xml, make the changes, 
then choose an ASDM option outside the Secure Desktop Manager menu, and click Discard 
Changes.

Step 2 Click the end node named Default.

This end node represents an endpoint profile. Note that Secure Desktop Manager displays the name of 
this end node in its menu.

Secure Desktop Manager inserts a window that lets you change the type and name of the end node 
(Figure 4-2).
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Figure 4-2 Change End Node Window

Note that the Policy option is already selected. In this case, you only need to change the name.

Step 3 Replace the name Default in the text box with the name Secure.

Step 4 Click Update.

Secure Desktop Manager closes the change end node window, and changes both the name of the end 
node and the associated menu option in the Secure Desktop Manager menu (Figure 4-3).

Figure 4-3 Default Policy Name Changed

Step 5 Click the plus sign in the diagram.

A window opens below the diagram, prompting you to select the type of check to be inserted 
(Figure 4-4).
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Figure 4-4 Prelogin Assessment Options

Step 6 Choose OS Check and click Add.

Secure Desktop Manager inserts the OS check node into the diagram (Figure 4-5).

Figure 4-5 OS Check

Step 7 Click the plus sign to the left of the Secure node.

Step 8 Select IP Address Check and click Add.

Secure Desktop Manager inserts the IP Address Check node and opens the IP address check window 
below the diagram. Figure 4-6 shows the default Mask attributes in the IP address check window.
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Figure 4-6 IP Address Check (Default Mask Attributes Displayed)

Step 9 Click Range to change the type of IP address check.

Secure Desktop Manager changes the attributes in the IP address check window(Figure 4-7).

Figure 4-7 Range Attributes in the IP Address Check Window

Step 10 Enter the IP address range and subnet mask, then click Update. 

Step 11 Click the plus sign to the left of the Secure node.

Step 12 Select Registry Check and click Add.

Secure Desktop Manager inserts the Registry Check node and opens the Registry check window below 
the diagram (Figure 4-8).
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Figure 4-8 Registry Check

Note The prelogin assessment ignores registry checks if the computer is running Mac OS or Linux. 

Step 13 Select an option next to the Key Path drop-down menu such as HKEY_LOCAL_MACHINE,” type the 
string to indicate the remainder or the path such as “SOFTWARE\Company-Name,” select a radio button 
such as Exists, and click Update.

This step completes the instructions for creating checks for the example Secure node.

Configuring Prelogin Criteria for a Home Computer
Use the following instructions to specify criteria for a CSD policy for home computers attempting VPN 
connections. In this example, CSD verifies the presence of a certificate to qualify users who connect 
from home.

Complete the example prelogin assessment for home computers as follows:

Note These instructions assume you have followed the instructions in the previous section.

Step 1 Choose Prelogin Policy.

Step 2 Click the Login Denied end node that follows the IP Address Failure branch.

Secure Desktop Manager inserts a window that lets you change the type and name of the end node.

Step 3 Click the Subsequence radio button, replace the text in the box with the name Home Check, and click 
Update.
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Secure Desktop Manager inserts a window that lets you change the type and name of the end node.

Step 4 Scroll to the Home Check node on the left side of the diagram and click the Login Denied end node to 
its right.

Step 5 Click the Policy radio button and replace the text in the box with the word Home.

Step 6 Click the plus sign to the left of the end node labeled Home.

Step 7 Select Certificate Check. and click Add.

Secure Desktop Manager inserts the Certificate Check node and opens the Certificate check window 
below the diagram (Figure 4-9).

Figure 4-9 Certificate Check

Note The prelogin assessment ignores certificate checks if the computer is running Mac OS or Linux. 

Step 8 Select an option from the drop-down box to specify the certificate field to be checked, enter the value of 
the field to match in the adjacent text box, enter the issuer of the certificate into the Issuer text field, and 
click Update.

For each additional field of a single certificate that you want to match, create another prelogin check that 
species that field and value.

Step 9 Click the plus sign to the left of the end node labeled Home.

Step 10 Select File Check and click Add.

Secure Desktop Manager inserts the File Check node and opens the File check window below the 
diagram (Figure 4-10).
4-8
Cisco Secure Desktop Configuration Guide



 

Chapter 4      Tutorial: Assigning Prelogin Criteria to Policies
Configuring a Prelogin Assessment
Figure 4-10 File Check

Step 11 Enter a path to the file in the drop-down box, select a radio button such as Exists, and click Update.

Note Secure Desktop Manager retains the case of the text you enter to check for a path to a file on the 
remote device. The match results are case-sensitive only if the devices are running Mac OS or 
Linux. The Microsoft Windows file system is not case-sensitive.

Step 12 Repeat Steps 9–10 to insert an additional file check.

This step completes the instructions for creating checks for the example Secure node. Continue with the 
next section to create the checks for the example Home node.

Configuring Prelogin Criteria for a Public Computer
Use the following instructions to specify criteria for a CSD policy for a public computer attempting a 
VPN connection.

These instructions say to add several prelogin file checks to qualify a Windows computer for Cache 
Cleaner, however, you can use any prelogin checks, or replace any Login Denied end node with a 
“Public” end node if you do not want to require a match.

Note These instructions assume you have followed the instructions in the previous sections.

Step 1 Choose Prelogin Policy.

Step 2 Click the Login Denied end node that follows the Win 9x branch.

Step 3 Click the Subsequence radio button, replace the text in the box with the name Public Check, and click 
Update.
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Step 4 Change the Login Denied end nodes that follow the IP Address Check, Certificate Check, and File check 
boxes to a subsequence end node, also named Public Check.

Step 5 Scroll to the Public Check node on the left side of the diagram and click the Login Denied end node to 
its right.

Step 6 Click the Policy radio button and replace the text in the box with the word Public.

Step 7 Insert two File Checks to the left of the Public end node.

This step completes the configuration of the example prelogin assessment. The diagram of your prelogin 
assessment should look like the one shown in Figure 4-11.

Figure 4-11 Example Prelogin Configuration

Continue with the next section to assign the Secure Desktop and Cache Cleaner settings appropriate for 
each endpoint profile.
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Configuring Secure Desktop and Cache Cleaner
The following sections describe how to enable or disable Secure Desktop (Vault) and Cache Cleaner for 
each endpoint profile and how to configure scanning for keystroke loggers:

 • Enabling or Disabling Secure Desktop and Cache Cleaner

 • Configuring Keystroke Logger Scanning

Enabling or Disabling Secure Desktop and Cache Cleaner
For each endpoint profile, click the name of the endpoint profile in the Secure Desktop menu. 
The Privacy Protection pane opens. Figure 4-12 shows the default settings for each endpoint profile.

Figure 4-12 Privacy Protection

This window lets you specify whether to run Secure Desktop (Vault) or Cache Cleaner on the remote 
desktops of computers that match the criteria associated with the selected profile.

Note If you check Secure Desktop, make sure that both the Secure Desktop and Cache Cleaner settings are 
appropriate for this policy. Cache Cleaner serves as a fall-back security solution for operating systems 
that Secure Desktop does not support.

See Table 4-1 to check or uncheck Secure Desktop or Cache Cleaner.

Table 4-1 Privacy Protection—Example Values

Action and Attribute

Endpoint Profile

Secure Home Public

Check Secure Desktop? No Yes —

Check Cache Cleaner? No — Yes
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Configuring Keystroke Logger Scanning
By default, keystroke logger scanning is disabled. Keep it disabled for the Secure endpoint profile. 
Configure scanning for keystroke loggers once for the Home endpoint profile and once for the Public 
profile, as follows:

Step 1 Click Keystroke Logger & Safety Checks under the name of the endpoint profile you are configuring 
in the menu on the left.

The Keystroke Logger window opens (Figure 4-13).

Figure 4-13 Keystroke Logger & Safety Checks

See Table 4-2 to check the attributes in this window.
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Step 2 Check Check for keystroke loggers to scan for a keystroke logging application on the remote PC and 
make sure one is not running, before creating the Secure Desktop space on the remote client.

By default, this attribute is not checked, and the other attributes and buttons are grayed out. If you check 
this attribute, the “Force admin control on list of safe modules” attribute becomes active.

Step 3 Check Force admin control on list of safe modules to specify which key loggers are exempt from 
scanning, or uncheck it to let the remote user decide.

If you check this attribute, the Add button become active.

Uncheck this attribute if you want to give the remote user the right to determine if any detected keystroke 
logger is safe. If this attribute is unchecked, the CSD installer lists the keystroke loggers discovered on 
the client computer. To access Secure Desktop, the user must insert a check next to all of the keystroke 
loggers in the list to indicate they are safe. Otherwise, the user must terminate the session.

Note Unchecking this attribute deactivates but does not delete the contents of the “List of Safe 
Modules” window.

Step 4 Click Add to specify a module as safe, or choose an entry in the List of Safe Modules window and click 
Edit if you want to modify its path.

Secure Desktop Manager opens the Input dialog box.

Step 5 Type the path and name of the module or application in the Please enter module path field, then click 
OK.

Secure Desktop Manager closes the dialog box and lists the entry in the List of Safe Modules window.

Note To remove a program from the list, click the entry in the “Path of safe modules” list, then click 
Delete.

Table 4-2 Keystroke Logger & Safety Checks—Example Values

Action and Attribute

Endpoint Profile

Secure Home Public

Check for keystroke 
loggers

No Yes Yes

Check Force Admin 
control on list of safe 
module?

— No Yes

Populate List of Save 
Modules?

— — Yes

Check for host 
emulation?

No Yes Yes

Check Always deny 
access if running within 
emulation?

— — Yes
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Assigning a DAP for Each Endpoint Profile

Note These instructions assume you have followed the instructions in the previous sections of this 
tutorial.

Configure a dynamic access policy (DAP) to support an endpoint profile as follows:

Step 1 Choose Configuration > Remote Access VPN > Network (Client) Access or Clientless SSL VPN 
Access > Dynamic Access Policies > Add or Edit.

The Add or Edit Dynamic Policy window opens (Figure 4-14).
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Figure 4-14 Add Dynamic Access Policy

Step 2 Use the Policy Name field at the top of the window to name the DAP.

Step 3 Move the mouse to the right of the Endpoint Attribute table and click Add.

The Add Endpoint Attribute window opens (Figure 4-15).
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Figure 4-15 Add Endpoint Attribute

Step 4 Select Policy from the drop-down list next to the Endpoint Attribute Type.

Step 5 Select the name of the prelogin policy from the drop-down list.

Step 6 Click OK.

The Add or Edit Endpoint Attribute window closes, leaving the Add or Edit Dynamic Policy window 
open.

Step 7 For each entry in the Basic Host Scan table, click Add to the right of the Endpoint Attribute table. Select 
the type (Registry, File, or Process) next to the Endpoint Attribute Type attribute, select the entry in the 
Endpoint ID box, and click OK.

Step 8 For each antispyware, antivirus, and personal firewall application you would like to require as part of the 
DAP, click Add to the right of the Endpoint Attribute table. Select the type (Antispyware, Antivirus, or 
Personal Firewall) next to the Endpoint Attribute Type attribute, select the company and application, and 
click OK.

Step 9 Set the attribute values in the tabs at the bottom of the Add Dynamic Access Policy window to configure 
access rights and restrictions, then click OK.
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Details: Assigning Prelogin Criteria to Policies

When a remote PC attempts to establish a remote VPN connection, CSD automatically checks for the 
conditions you configure, and assigns the attribute settings of the prelogin policy associated with the 
result of the checks to the connection, or issues a Login Denied message.

A prelogin assessment consists of the matching criteria associated with the prelogin policies. Use the 
following sections to configure the prelogin assessment to be downloaded to the remote PC:

 • Understanding Prelogin Policies

 • Checking for a Registry Key (Microsoft Windows Only)

 • Checking for a File

 • Checking for a Certificate

 • Checking the OS

 • Checking for an IP Address

 • Modifying the Prelogin Assessment Configuration

Understanding Prelogin Policies
Secure Desktop Manager lets you specify the checks to be performed between the time the user 
establishes a connection with the security appliance and the time the user enters the login credentials. 
These checks determine whether to assign a prelogin policy or whether to display a “Login Denied” 
message for the remote user. The settings of the matched prelogin policy determine whether Secure 
Desktop (Vault) or Cache Cleaner loads. The application of a prelogin policy to a dynamic access policy 
(DAP) determines the access rights and restrictions placed on the connection, and determines the 
behavior of the CSD component before, during, and after the user logs in. For example, it determines 
whether to check for keystroke loggers or whether to apply an inactivity timeout.

To view the prelogin assessments present in the configuration, choose Secure Desktop Manager > 
Prelogin Policy.

Figure 5-1 shows the default prelogin assessment configuration, including the default prelogin policy 
named “Default.”
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Understanding Prelogin Policies
Figure 5-1 Default Elements in the Prelogin Policy Pane

By default, the Prelogin Policy pane displays the following elements:

 • Start—Displayed in blue, this node provides a visual indication of the beginning of the sequence of 
checks to be performed. You cannot edit the start node.

 • Line—Provides a visual indication of the conditional relationship of the node to its left and the one 
that follows. You cannot move or remove a line.

 • Plus sign—Click to insert a prelogin check between the two nodes on either side of the line. Secure 
Desktop Manager lets you insert the following types of checks:

 – Registry—Lets you detect the presence or absence of a registry key.

 – File—Lets you specify the presence or absence of a particular file, its version, and its checksum.

 – Certificate—Lets you specify the issuer of a certificate and one certificate attribute and value to 
match. 

For each additional attribute of a single certificate that you want to match, create another 
prelogin check that species that attribute and value.

 – OS Check—Lets you configure checks for Microsoft Windows 2000, Windows XP, and 
Windows Vista; Win 9x (for Windows 98), Mac (for Apple Mac OS X 10.4), and Linux. The 
editor inserts a Failure line and Login Denied end node for remote connections that fail the OS 
checks.

 – IP Address—Lets you specify an IP address range, or network address and subnet mask.

 • Default—Displayed in green, this end node specifies a prelogin policy named “Default.” By default, 
CSD assigns this profile to every remote computer that attempts a VPN session, if you enable CSD. 
You can add prelogin checks to this policy or any other prelogin policy to specify criteria to match 
before CSD assigns the policy to a remote VPN session.
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Checking for a Registry Key (Microsoft Windows Only)
If you insert a check before an end node, Secure Desktop Manager automatically assigns at least one 
instance of each of the following:

 • Success tag to the line leading from the new check to the prelogin policy that is already present.

 • Failure tag to a second line leading from the new check to a “Login Denied” node. This node, 
displayed in red, signifies that a “Login Denied” message appears; CSD denies the user access to 
the security appliance.

You can change the name or type of any node except for the Start node. You can change an end node 
following a Success tag to a Login Denied node, and the end node following a Failure tag to a prelogin 
policy. You can also change either type of end node to a subsequence node. Displayed in blue, this node 
indicates a continuation to another blue node vertically aligned under the Start node. To assign a 
subsequence to a set of conditions, click an end node, then click Subsequence. You must assign a unique 
name to each subsequence you create. Secure Desktop Manager assigns the name to both instances of 
the subsequence node–the one at the end of the branch–and the one at the beginning of the new branch. 
To reuse a subsequence, type the name of the subsequence that is already present when you are changing 
an end node to a subsequence node.

You can rename any prelogin policy, including the one named “Default.” To do so, return to the Prelogin 
Policy pane and click the “Default” node. Replace the text in the Label field with a name for a prelogin 
policy that is meaningful to you. For example, you may want to rename it “Secure” to indicate the profile 
applies to corporate PCs (that is, those that meet the most stringent requirements, as determined by the 
checks to be inserted). Secure Desktop Manager automatically renames the node in the associated 
menu.You can then adjust the settings for the prelogin policy accordingly.

Checking for a Registry Key (Microsoft Windows Only)

The prelogin assessment ignores registry key checks if the computer is running Mac OS or Linux. 

Insert a check for a specific registry key on a remote computer running a Microsoft Windows operating 
system, as follows:

Step 1 Choose Prelogin Policy.

Step 2 Determine the position of the registry check to be inserted and click the associated plus sign.

A window prompts you for the type of check to be inserted.

Step 3 Choose Registry Check and click Add.

Secure Desktop Manager inserts the Registry Check node into the window and opens the Registry Check 
window (Figure 5-2).
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Figure 5-2 Registry Check

Tip You can use the value types to be specified in this window as a guide to set up one or more criteria within 
the remote PC to match those specified for this prelogin policy. For example, you can add a DWORD 
(double word, an unsigned 32-bit integer) value or string value to a registry key on a remote PC to qualify 
it for the prelogin policy you are configuring.

Step 4 Assign values to the mandatory attributes in the Registry Check window as follows:

 • Key Path menu—Choose the hive, the initial directory path to a registry key. The options are as 
follows:

HKEY_CLASSES_ROOT\
HKEY_CURRENT_USER\
HKEY_LOCAL_MACHINE\
HKEY_USERS\

Each string references a registry base that stores different information. The HKEY_LOCAL_MACHINE\ 
path is the most commonly used one because it contains the machine-specific registry files.

 • Key Path field—Enter the name of the registry key required to be present on or absent from the 
remote PC.

Caution Do not type quotes in a Registry Key name that includes spaces.

Refer to the subsequent attribute descriptions for examples of Entry Path strings.

Step 5 Click one radio button from the following list and assign the associated values:

 • Exists—Click if the mere presence of the named registry key on the remote PC is sufficient to match 
the prelogin policy you are configuring.
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EXAMPLE Click Exists if you want to require the following registry key to be present to match a 
criterion for assigning a prelogin policy:

HKEY_LOCAL_MACHINE\SOFTWARE\<Protective_Software>

 • Does not exist—Click if the absence of the named registry key from the remote PC is sufficient to 
match the prelogin policy you are configuring.

EXAMPLE Click Does not exist if you want to require the following registry key to be absent to 
match a criterion for assigning a prelogin policy:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run\<Evil_SpyWare>

 • DWORD value radio button—Click if the registry key includes a “Dword” (“double word,” a 32-bit 
integer) and you want to specify its value as a criterion.

“DWORD” refers to the attribute in the Add/Edit Registry Criterion dialog box. “Dword” refers to 
the attribute as it appears in the registry key.

Note Use the regedit application, accessed on the Windows command line, to view the Dword 
value of a registry key, or use it to add a Dword value to the registry key to satisfy the 
requirement you are configuring. 

 • DWORD value menu—Choose an option (<, <=, =, !=, >, or >=) to specify the relationship of the 
Dword value of the registry key to the value to be entered to the right.

 • DWORD value field—Enter a decimal to compare with the Dword value of the registry key on the 
remote PC.

EXAMPLE Choose greater than or equal to and enter a decimal if you want to require that the 
following protective software application meet a minimum version requirement:

HKEY_LOCAL_MACHINE\SOFTWARE\<Protective_Software>\Version

 • String value radio button—Click if the registry key includes a string and you want to specify its 
value as a criterion. 

Note Use the regedit application, accessed on the Windows command line, to view the String 
value of a registry key, or use it to add a String value to the registry key to satisfy the 
requirement you are configuring.

 • String value menu—Choose one of the following options to specify the relationship of the String 
value of the registry key to the value to be entered to the right:

 – contains

 – matches

 – differs

 • String value field—Enter a string to compare with the String value of the registry key on the remote 
PC.

EXAMPLE Choose matches and enter Active if you want to ensure the following protective 
software application is active:

HKEY_LOCAL_MACHINE\SOFTWARE\<Protective_Software>\Status

Case sensitive—Check to require the String value of the registry key on the remote PC to match the 
case used in the String value field to satisfy the criterion.
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Checking for a File
Step 6 Click Update.

Checking for a File

The file criterion prelogin check lets you specify that a certain file must or must not exist to be eligible 
for the associated prelogin policy. For example, you might want to use a file prelogin check to ensure a 
corporate file is present or one or more peer-to-peer file-sharing programs containing malware are not 
present before assigning a prelogin policy.

Use the following procedure to insert a prelogin assessment for files on the remote PC:

Step 1 Choose Prelogin Policy.

Step 2 Determine the position of the file check to be inserted and click the associated plus sign.

A window prompts you for the type of check to be inserted.

Step 3 Choose File Check and click Add.

Secure Desktop Manager inserts the File Check node into the window and opens the File Check window 
(Figure 5-3).

Figure 5-3 File Check

Step 4 Assign a value to the following mandatory attribute:

 • File Path—Enter the directory path to the file.

Secure Desktop Manager retains the case of the text you enter to check for a path to a file on the 
remote device. The match results are case-sensitive only if the devices are running Linux or Mac OS. 
The Microsoft Windows file system is not case-sensitive.

For example,

C:\Program Files\Cisco Systems\CSAgent\bin\okclient.exe
5-6
Cisco Secure Desktop Configuration Guide



 

Chapter 5      Details: Assigning Prelogin Criteria to Policies
Checking for a File
Step 5 Click one of the following mandatory radio buttons:

 • Exists—Click if the file must be present on the remote PC.

 • Does not exist—Click if the file must be absent from the remote PC, then go to Step 7. 

Step 6 Use the following attributes if you want to specify the file version.

 • Version check box—Check if you want to specify the version of the file as a criterion. Use this 
criterion to require that a specific application is or is not a particular version.

Note To display the version of an .exe file, use Windows Explorer to right-click the file, choose 
Properties, and click the Version tab.

 • Version drop-down list—Choose an option (<, <=, =, !=, >, or >=) to specify the relationship of the 
version of the file to the string to be entered to the right.

 • Version field—Type a string to compare with the version of the file on the remote PC.

 • Checksum check box—Check to specify a checksum to authenticate the file named in the Path field.

 • Checksum field—Enter a checksum in hexadecimal format, beginning with 0x, or click Compute 
CRC32 Checksum to calculate the checksum of a file stored locally and insert the value in this field.

The Compute CRC32 Checksum dialog box opens (Figure 5-4).

Figure 5-4 Compute CRC32 Checksum

Retrieve the checksum as follows:

a. Click Browse and choose the file on which to calculate the checksum.

The field at the top of the Compute CRC32 Checksum dialog box displays the path to the file you 
chose.

b. Click Calculate.

The field at the bottom of the Compute CRC32 Checksum dialog box displays the checksum in 
hexadecimal format.

c. Click OK.

The Compute CRC32 Checksum dialog box closes and the hexadecimal value appears in the 
Checksum field.

Step 7 Click Update in the File Check window.
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Checking for a Certificate

The prelogin assessment checks certificates on Microsoft Windows, Mac OS, and Linux.

Insert a check for a specific certificate on the remote computer as follows:

Step 1 Go to the Secure Desktop Manager menu on ASDM and choose Prelogin Policy.

Step 2 Determine the position of the certificate check to be inserted and click the associated plus sign.

A window prompts you for the type of check to be inserted.

Step 3 Choose Certificate Check and click Add.

Secure Desktop Manager inserts the Certificate Check node into the window and opens the Certificate 
Check window (Figure 5-5).

Figure 5-5 Add Certificate Check

Note Insert more than one certificate check if you want to require more than one match.

Step 4 Use the applicable procedure in Table 5-1 to begin the process of choosing a certificate attribute to 
evaluate for a match, and to identify the issuer of the certificate.

Table 5-1 Viewing Certificate Attributes and Values

Certificate (.cer) File File that Contains a Certificate Certificate Store

Double-click the certificate. a. Right click the file and 
choose Properties.

b. Click the Digital 
Signatures tab (which 
appears only if the file is 
signed).

c. Click Details.

d. Click View Certificate.

e. Click the Details tab.

a. Open the Control Panel.

b. Choose Internet Options.

c. Click the Content tab.

d. Click Certificates.

e. Choose a certificate and 
click View.
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Step 5 Do one of the following:

 • Click the General tab in the Certificate window and copy the string from the Issued to field to the 
Issued to text box in ASDM.

 • Click the Details tab in the Certificate window, then click the Issuer or Subject field below it.

The certificate issuer displays all of the Issuer or Subject values in the adjacent Value column, and 
lists each distinct parameter and value associated with the Issuer or Subject field in the box at the 
bottom of the window.

The format of the parameter names in the bottom box varies, depending on the certificate authority. 
The following list matches the parameters in the ASDM drop-down list with the typical parameter 
name in parentheses. The absence of a name in parentheses in this list indicates that the parameter 
usage is not typical.

 – Common Name (CN)

 – Given Name (GN)

 – Surname (SN)

 – Country (C)

 – Locality (L)

 – State or Province (ST)

 – Street Address (STREET)

 – Organization (O)

 – Organizational Unit (OU)

 – Title (T)

 – Description

 – Business Category

 – Postal Address (PA)

 – Postal Code (POSTALCODE)

 – Member (M)

 – Owner

 – Role Occupant

 – Initials (I)

 – Dn Qualifier (DNQ)

 – Domain Component (DC)

In ASDM, select the name of a parameter associated with one displayed on the bottom window on 
the Details tab. Then copy the adjacent value to the top, unnamed text box in the ASDM Add 
Certificate window.

Step 6 Click the General tab on the Certificate window, and copy the string from the Issued by field to the 
Issuer text box in the ASDM Add Certificate window.

Step 7 Click Update.
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Checking the OS

The prelogin assessment includes a check for the OS attempting to establish a VPN connection. When 
the user attempts to connect, however, CSD automatically checks for the OS, regardless of whether you 
insert an OS prelogin check. 

If the prelogin policy assigned to the connection has Secure Desktop (Vault) enabled and if the remote 
PC is running Microsoft Windows Vista, Windows XP, or Windows 2000, it installs Secure Desktop, 
regardless of whether you insert an OS prelogin check. If the prelogin policy has Secure Desktop enabled 
and the operating system is Mac OS X 10.4 or 10.5, or Linux, Cache Cleaner runs instead. Therefore, 
you should make sure the Cache Cleaner settings are appropriate for a prelogin policy on which you have 
configured Secure Desktop or Cache Cleaner to install. 

Although CSD automatically checks for the OS, you may want to insert an OS prelogin check as a 
condition for applying a prelogin policy to isolate subsequent checks for each OS.

Use the following procedure to insert an OS check:

Step 1 Choose Prelogin Policy.

Step 2 Determine the position of the Windows check to be inserted and click the associated plus sign.

A window prompts you for the type of check to be inserted.

Step 3 Choose OS Check and click Add.

Secure Desktop Manager inserts the OS check node into the diagram (Figure 5-6).

Figure 5-6 OS Check

If you wish, you can click any Login Denied node to change it to a prelogin policy or a subsequence 
node. 

Checking for an IP Address

You can insert a check for the IP address of a remote host attempting a VPN connection, into the prelogin 
assessment. If the IP address is within the number range or the range specified by the network address, 
the remote host passes the check; otherwise, it fails. For example, PCs connecting from within a 
workplace LAN on a 10.x.x.x network are an unlikely risk for exposing confidential information. For 
these PCs, you might set up a prelogin policy named Secure that is specified by IP addresses on the 
10.x.x.x network, and disable the prelogin policy settings that enable the installation of Cache Cleaner 
and Secure Desktop.
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Note If the PC has more than one IP address, CSD uses only the first address detected. 

Use the following procedure to check for an IP address as part of a prelogin assessment:

Step 1 Choose Prelogin Policy.

Step 2 Determine the position of the IP address check to be inserted and click the associated plus sign.

A window prompts you for the type of check to be inserted.

Step 3 Select IP Address Check and click Add.

Secure Desktop Manager inserts the IP Address Check node and opens the IP address check window 
below the diagram. The IP address check window to the left in Figure 5-7 shows the default Mask 
attributes, and the IP address check window to the right shows the attributes that display when you click 
Range.

Figure 5-7 IP Address Check (Both Mask and Range Options Displayed)

Step 4 Choose either of the following options to indicate the type of IP address check:

 • Click Mask and enter the network address and subnet mask.

 • Click Range and enter the IP address in the From fields, leaving a 0 in one or more of the right-most 
fields to indicate the range, and enter the subnet mask in the To fields.

Step 5 Click Update.
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Modifying the Prelogin Assessment Configuration

You can modify any node in the Prelogin Policy window except for the Start and OS nodes. You can 
delete any node except for the Start and end nodes. To modify or delete a node window, click the node. 
Make the changes as needed and click Update, or click Delete to remove the node from the 
configuration.

To insert a prelogin check, click the plus sign located in the position where you want to insert the check. 
Secure Desktop Manager inserts the window that lets you specify the check you want to select. After 
doing so, click Add. Use the instructions in the previous section to set the attributes in the check type 
window and click Update.

To change the type and name of any end node, double click the end node, click Login Denied, Policy, 
or Subsequence to change the node type, type the name of the node in the Label field if it is of type 
Policy or Subsequence, and click Update.
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Assigning Secure Desktop, Cache Cleaner, and 
Detection Settings to Policies

See the following sections to specify CSD policy settings:

 • Enabling and Disabling Secure Desktop or Cache Cleaner

 • Configuring Keystroke Logger and Host Emulator Detection

 • Configuring Cache Cleaner

 • Configuring Secure Desktop (Vault) General

 • Configuring Secure Desktop (Vault) Settings

 • Configuring the Secure Desktop (Vault) Browser

Enabling and Disabling Secure Desktop or Cache Cleaner
To view and change the settings assigned to a prelogin policy, note the label on the green end node of 
the Prelogin Policy pane, then click the menu with the same name in the Secure Desktop Manager menu. 
The Privacy Protection pane for that policy opens (Figure 6-1).
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Figure 6-1 Privacy Protection

This pane lets you specify a remote installation module to run on any remote computer that matches the 
prelogin policy criteria.

Check one of the following:

 • Secure Desktop—To run Secure Desktop (Vault) on the remote PC.

Note If you check Secure Desktop, make sure that both the Secure Desktop and Cache Cleaner 
settings are appropriate for this policy. Cache Cleaner serves as a fall-back security solution 
for operating systems that Secure Desktop does not support.

 • Cache Cleaner—To run Cache Cleaner on the remote PC.

 • Neither Secure Desktop nor Cache Cleaner—Uncheck both options if the PC is secure (for example, 
if the prelogin checks reveal the PC is a corporate computer) or you do not want either module to 
load.

Configuring Keystroke Logger and Host Emulator Detection
You can configure each prelogin policy to scan for keystroke logging applications on Windows and deny 
access if a suspected keystroke logging application is present. You can specify the keystroke logging 
applications that are safe or let the remote user interactively approve the applications the scan identifies.

Host emulation detection, another feature of prelogin policies, determines whether a remote Microsoft 
Windows operating system is running over virtualization software. You can enable or disable this feature 
to deny access if a host emulator is present, or report the detection to the user and let the user decide 
whether to end the session.

By default, keystroke logger detection and host emulation detection are disabled for each prelogin 
policy. If you enable them, they download along with Secure Desktop, Cache Cleaner, or Host Scan onto 
the remote computer. The associated module runs only if the scan is clear, or only if you assign 
administrative control to the user and the user approves of the applications or host emulator the scan 
identifies. 
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Note CSD only detects keystroke loggers if the user has administrator privileges. If the user does not, 
keystroke logger detection does not run.

Keystroke logger detection and host emulation detection support Microsoft Windows Vista, Windows 
XP, and Windows 2000.

Configure scanning for keystroke loggers as follows:

Step 1 Click Keystroke Logger & Safety Checks under the name of the prelogin policy you are configuring 
in the menu on the left.

The Keystroke Logger & Safety Checks window opens (Figure 6-2).

Figure 6-2 Keystroke Logger & Safety Checks

The “List of Safe Modules” window lists the paths to program applications on the remote PC that have 
keystroke logging capabilities, but are safe to use, as determined by the administrator. Such programs, 
such as Corel (previously Jasc) Paint Shop Pro, typically invoke functions when the user presses 
particular keystroke combinations from within another application.

Step 2 Check Check for keystroke loggers to scan for a keystroke logging application on the remote PC.

By default, this attribute is not checked, and the other attributes and buttons are grayed out. If you check 
this attribute, the “Force admin control on list of safe modules” attribute becomes active.
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Step 3 Check Force admin control on list of safe modules to specify which keystroke loggers are exempt from 
scanning, or uncheck it to let the remote user decide.

If you check this attribute, the Add button become active.

Uncheck this attribute if you want to give the remote user the right to determine if any detected keystroke 
logger is safe. If this attribute is unchecked and suspect modules are detected, a window on the remote 
PC lists the path and name of each suspected module. To determine whether a given module is safe, the 
user can click the “Click for info” link adjacent to the name to display Internet search results for the 
module. To run Secure Desktop, Cache Cleaner, or Host Scan, the user must insert a check next to all of 
the keystroke loggers in the list to acknowledge that they are safe. Otherwise, the user must terminate 
the session.

Note Unchecking this attribute deactivates but does not delete the contents of the “List of Safe 
Modules” window.

Step 4 Click Add to specify a module as safe, or choose an entry in the List of Safe Modules window and click 
Edit if you want to modify its path.

Secure Desktop Manager opens the Input dialog box.

Step 5 Type the full path and name of the module or application in the Please enter module path field, then 
click OK.

You can also enter environment variables to specify whitelist entries. For example:

 • %windir%\system32\keylogger.exe

 • %programfiles%\mylogger\logme.exe

 • %commonprogramfiles%\logger\watch.exe

Secure Desktop Manager closes the dialog box and lists the entry in the List of Safe Modules window.

Note To remove an entry from the list, click it in the “Path of safe modules” list, then click Delete.

Step 6 Check Check for host emulation if you want to determine whether the operating system is running over 
virtualization software, such as VMWare.

Step 7 Check Always deny access if running within emulation to prevent the module (Secure Desktop, Cache 
Cleaner, or Host Scan) from running if CSD detects that the operating system is running over 
virtualization software. Uncheck this attribute to alert the user about the host emulation software and let 
the user choose whether to terminate the session. 

Step 8 Click Apply All to save the configuration changes.
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Configuring Cache Cleaner
Cache Cleaner attempts to disable or erase data that a user downloaded, inserted, or created in the 
browser, including cached files, configuration changes, cached browser information, passwords entered, 
and auto-completed information. Cache Cleaner supports the following:

 • WebLaunch of Cisco AnyConnect running on Microsoft Windows, Mac OS, and Linux. 

 • Clientless (browser-based) SSL VPN connections on Windows Vista, Windows XP, Windows 2000, 
Mac OS X 10.4, and Linux.

Cache Cleaner does not support the standalone startup of AnyConnect Client from any computer.

For each prelogin policy for which either Secure Desktop (Vault) or Cache Cleaner is enabled, click 
Cache Cleaner under the profile you are configuring. The Cache Cleaner pane appears. Figure 6-3 
shows the default settings.

Figure 6-3 Cache Cleaner

This window lets you configure the Cache Cleaner for the associated prelogin policy. Check the 
following fields as required by your security policy:

 • Launch hidden URL after installation—(For Microsoft Windows only. Cache Cleaner ignores it if 
the operating system is Mac OS or Linux.) Check to use a URL for administrative purposes, hidden 
from the remote PC, so that you know that the user has the Cache Cleaner installed. For example, 
you could place a cookie file on the user's PC, and later check for the presence of that cookie.
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 • Hidden URL—Type the URL to use for administrative purposes, if you checked “Launch hidden 
URL after installation.”

 • Show success message at the end of successful installation. (Windows only)—Check to display a 
dialog box on the remote PC informing the user when the Cache Cleaner installation is successful. 

 • Launch cleanup upon timeout based on inactivity—Check to close Cache Cleaner automatically 
after a period of mouse inactivity. This parameter applies only to Microsoft Windows. Cache 
Cleaner ignores it if the operating system is Mac OS or Linux. 

Note Network activity restarts the Idle Timeout (referred to here as the “traffic timer”). The traffic 
timer is configurable on the internal group policy. Either timer terminates the session if the 
user forgets to log out or could not log out properly (if the computer freezes, for example). 
When the mouse timer reaches its limit, the security appliance ends the session and closes 
the browser window. Any movement of the mouse connected to the remote computer restarts 
this timer, regardless of the application in use. The mouse timer ensures the user is still 
present even if a large download is in progress. The user of a Cache Cleaner session can view 
the countdown while they work by double-clicking the CSD lock icon next to the Windows 
time clock. The “Enable Secure Desktop inactivity timeout” on the Secure Desktop (Vault) 
General configuration panel performs the same function for Secure Desktop, except the 
countdown display automatically opens when nine seconds are left, accompanied by an 
optional audible timer that beeps each second. The traffic timer is useful for browsing web 
pages that take a short time to load but a long time to read. To configure the traffic timer, 
choose Configuration > Remote Access VPN > Network (Client) Access or Clientless SSL 
VPN Access > Group Policies > Add or Edit > General > More Options and change the value 
of the Idle Timeout attribute.

 • Timeout after—Choose the number of minutes (1, 2, 5, 10, 15, 30, or 60) to set the timeout period 
if you checked the “Launch cleanup upon timeout based on inactivity” attribute. This attribute is the 
associated inactivity timer. Read the note above before entering a number.

 • Launch cleanup upon closing of all browser instances or SSL VPN connection—Check to clean up 
the cache when all browser windows are closed or the user session is closed. 

 • Clean the whole cache in addition to the current session cache (IE only)—Check to remove data 
from the Internet Explorer cache. Upon activation, Cache Cleaner attempts to remove the files 
generated, browsing history, and typed fields and passwords retained before the session began.

 • Disable Cancel button—(For Microsoft Windows only) Check to prevent the remote user from 
canceling the deletion of the cache.

 • Secure Delete—Upon termination, Cache Cleaner performs a U.S. Department of Defense (DoD) 
sanitation algorithm to clean the browser cache. Choose the number of times to perform this cleanup 
task. The default setting is 3 passes. Following the completion of the task the number of times 
specified, Secure Desktop removes the pointer to the file.

Note Click Apply All to save the running CSD configuration.
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Configuring Secure Desktop (Vault) General
Click Secure Desktop (Vault) General under the prelogin policy name to enable or disable the Secure 
Desktop (Vault) features and customize the user experience. 

The Secure Desktop (Vault) General pane appears. Figure 6-4 shows the default settings.

Figure 6-4 Secure Desktop (Vault) General

Check the following attributes to configure the general Secure Desktop settings for the prelogin policy 
you are configuring, as required by your security policy:

 • Enable switching between Secure Desktop and Local Desktop—We strongly recommend that you 
check this attribute to let users switch between Secure Desktop and the untrusted desktop. Called 
desktop switching, this feature provides users with the flexibility they might need to respond to a 
prompt from another application requiring an OK to let Secure Desktop continue processing. 
Unchecking this attribute minimizes the potential security risk posed by a user who leaves traces on 
the untrusted desktop. You might choose to uncheck this option if the deployment advantages 
outweigh the security risk. If you permit switching, a Windows XP user can switch between the 
Secure Desktop and an AnyConnect session running on the local desktop. Operating System 
limitations may prevent Secure Desktop from enforcing prevention of desktop switching, even if this 
feature is disabled. AnyConnect and Secure Desktop cannot run simultaneously on Windows Vista.
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 • Enable Vault Reuse—Check to allow users to close Secure Desktop and open it again at a later time. 
Secure Desktop becomes a persistent desktop that is available from one session to the next. If you 
enable this option, users must enter a password (up to 127 characters in length) to restart Secure 
Desktop. This option is useful if users are running Secure Desktop on PCs that are likely to be 
reused; for example, a home PC. When a user closes Secure Desktop, it does not self-destruct. If 
you do not enable this option, Secure Desktop automatically self-destructs upon termination. 

If unchecked, this attribute activates the following two attributes.

 • Suggest application uninstall upon Secure Desktop closing—Check to prompt the user and 
recommend that Secure Desktop be uninstalled when it closes. In contrast to the option below, the 
user has the choice to refuse the uninstallation. 

Note Checking this option uninstalls Secure Desktop from the remote PC when the user session 
closes, so leave this option disabled if access to Secure Desktop is important.

 • Force application uninstall upon Secure Desktop closing—Check if you do not want to leave Secure 
Desktop on untrusted PCs after users finish using it. Secure Desktop uninstalls when it closes. 

Note Checking this option uninstalls Secure Desktop from the remote PC when the session closes, 
so leave this option disabled if access to Secure Desktop is important.

 • Launch cleanup upon timeout based on inactivity—Check to close Cache Cleaner automatically 
after a period of mouse inactivity. This parameter applies only to Microsoft Windows. Cache 
Cleaner ignores it if the operating system is Mac OS or Linux.

 • Enable Secure Desktop inactivity timeout—Check to close Secure Desktop automatically after a 
period of mouse inactivity.

Note Network activity restarts the Idle Timeout (referred to here as the “traffic timer”). The traffic 
timer is configurable on the internal group policy. Either timer terminates the session if the 
user forgets to log out or could not log out properly (if the computer freezes, for example). 
When nine seconds remain on the mouse timer, a countdown display automatically opens, 
accompanied by an optional audible timer that beeps each second. Any movement of the 
mouse connected to the remote computer restarts this timer, regardless of the application in 
use. If the mouse timer reaches its limit, the security appliance ends the session and closes 
the browser window. The mouse timer ensures the user is still present even if a large 
download is in progress. The “Launch cleanup upon timeout based on inactivity” timer on 
the Cache Cleaner configuration panel performs the same function for Cache Cleaner, except 
the user double-clicks the CSD lock icon next to the Windows time clock to view the 
countdown. The audible timer associated with mouse movement is a feature provided only 
for Secure Desktop. The traffic timer is useful for browsing web pages that take a short time 
to load but a long time to read. To configure the traffic timer, choose Configuration > 
Remote Access VPN > Network (Client) Access or Clientless SSL VPN Access > Group 
Policies > Add or Edit > General > More Options and change the value of the Idle Timeout 
attribute.

If checked, this attribute activates the following attribute.

 • Timeout After—Choose the number of minutes (1, 2, 5, 10, 15, 30, or 60) to set the timeout period 
if you checked the “Enable Secure Desktop inactivity timeout” attribute. This attribute is the 
associated inactivity timer. Read the note above before entering a number.
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 • Open following web page after Secure Desktop closes—Check this box and enter a URL in the field 
to make Secure Desktop automatically open a web page when it closes.

 • Secure Delete—Secure Desktop encrypts and writes itself to the remote PC disk. Upon termination, 
it performs a U.S. Department of Defense (DoD) sanitation algorithm. Choose the number of times 
to perform this cleanup task. The default setting is 3 passes. Following the completion of the task 
the number of times specified, Secure Desktop removes the pointer to the file.

 • Launch the following application after installation—This option lets you start an application 
automatically after Secure Desktop installs on the remote PC. Enter only the path to the application 
that follows the C:\Program Files\ portion. The application must be in the Program Files directory.

Note Click Apply All to save the running CSD configuration.
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Configuring Secure Desktop (Vault) Settings
Click Secure Desktop (Vault) Settings under the prelogin policy name to place restrictions on Secure 
Desktop.

The Secure Desktop (Vault) Settings pane appears. Figure 6-5 shows the default settings.

Figure 6-5 Secure Desktop (Vault) Settings

Check the boxes to apply the associated restrictions. The restrictions are as follows:

 • Restrict application usage to the web browser only—Check to let only the originating browser and 
any browser helpers you specify run on Secure Desktop. Choosing this option limits the user's ability 
to use other applications, but increases the level of security.

If you check this attribute, Secure Desktop Manager inserts a text box under it (Figure 6-6).
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Figure 6-6 Restrict Application Usage

To specify browser helpers that can run on Secure Desktop, click Add Browser Helpers and select 
them from a preconfigured list. If the applications are not in the preconfigured list, enter the names 
of the executable files into the text box. The text is not case-sensitive. For added security, you can 
insert the full paths of the applications.

Caution If you check Restrict application usage, but want to provide users with access to Java applets 
on the web pages they open, you must add the following entries to the browser list: 
c:\program 
java.exe 
jp2launcher.exe

Otherwise, if you check Restrict application usage, browsers on systems with JRE 6 Update 10 or 
later freeze when they encounter Java applets. These lines are necessary for applets with Update 10 
and later because Java starts differently from standard practice. You must also add these lines as 
smart tunnel applications if you configure smart tunnel access.

Entering these lines provides access to all of the Java applets we tested; however, we recommend 
testing the Java applets that are most important to your users. Also, a few applets appear to load 
before they have completely done so; you might want to instruct your users to wait for a minute if 
an applet appears to fail.

The entries above do not interfere with Java applets for users who have JRE 6 versions that are 
earlier than Update 10.

(Optional) Specify a hash to help ensure the executable files are authentic. To do so, download the 
Microsoft File Checksum Integrity Verifier (FCIV). Then click the i icon under the text box, follow 
the instructions to use FCIV to calculate the SHA-1 hash, and add it to the file name.

 • Disable access to network drives and network folders—Leave checked to attempt to prevent user 
access to network resources and network drives while running Secure Desktop. The network 
resources are those that use the Server Message Block (SMB) client/server, request-response 
protocol to share such resources as files, printers, and APIs. Because CSD does not clean up files 
written to mapped network drives, we strongly recommend that you leave this attribute checked.
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 • Disable access to removable drives and removable folders—Check to prevent the user from 
accessing portable drives while running Secure Desktop. Otherwise, the user can save files to a 
removable drive and remove the drive before closing the session. After closing the session, the user 
could forget to take the removable drive. For maximum security, we recommend that you check this 
attribute.

This attribute applies only to the drives that Microsoft names “Removable” in the Windows Explorer 
“My Computer” window.

 • Disable registry modification—Check to prevent the user from modifying the registry from within 
Secure Desktop. For maximum security, we recommend that you check this attribute.

 • Disable command prompt access—Check to prevent the user from running the DOS command 
prompt from within Secure Desktop. For maximum security, we recommend that you check this 
attribute. 

 • Disable printing—Check to prevent the user from printing while using Secure Desktop. For 
maximum security of sensitive data, check this option.

 • Allow email applications to work transparently—Check to let the user open e-mail while on Secure 
Desktop and to prevent it from deleting e-mail upon the termination of the session. The use of the 
term transparent means that Secure Desktop handles e-mail the same way that the local desktop 
handles it. Transparent handling works for the following e-mail applications:

 – Microsoft Outlook Express 

 – Microsoft Outlook

 – Eudora 

 – Lotus Notes

If this attribute is checked and the remote user uses an e-mail application to save an attachment to 
the “My Documents” folder, it is visible from both Secure Desktop and the local desktop. Similarly, 
deleting such a file from within the e-mail application running over Secure Desktop removes the file 
from both desktops. 

Note Deleting transparent or nontransparent files from outside of Outlook, such as from a Windows 
Explorer window, while in a Secure Desktop removes the file only from Secure Desktop.

Click Apply All to save the running CSD configuration.

Configuring the Secure Desktop (Vault) Browser
Click Secure Desktop (Vault) Browser under the prelogin policy name to specify the URL that opens 
when the user in a Secure Desktop clicks Home. This option also lets you specify the folders and URLs 
that populate the Bookmarks or Favorites menu during the Secure Desktop session.

The Secure Desktop (Vault) Browser pane appears. Figure 6-7 shows the default settings.
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Figure 6-7 Secure Desktop (Vault) Browser

For the duration of the Secure Desktop session, the browser does not list the user’s bookmarks or 
favorites. It lists only the ones shown in this pane.

Configure the Secure Desktop (Vault) Browser as follows:

Step 1 Type the URL of the page that you want to open when the remote user clicks Home, into the Home Page 
field.

The Customized Bookmarks pane lists the folders and URLs that populate the browser Bookmarks or 
Favorites menu.

Step 2 Use the following guidelines to add, modify, and delete entries in the Customized Bookmarks pane:
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 • To add a folder, select the folder to contain it, click Add Folder, type the new folder name in the 
dialog box, then click OK.

 • To add a bookmark to the list, select the folder to contain it, click Add Bookmark, type the URL in 
the dialog box, then click OK.

 • To modify a URL, select it, click Edit, type the new URL in the dialog box, then click Edit.

 • To remove a folder or a URL, select it and click Delete.

Note Click Apply All to save the running CSD configuration.
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Using Match Criteria to Configure Dynamic Access 
Policies

You can match Host Scan results, prelogin policies, basic Host Scan entries, or any combination of these 
criteria with any other policy attributes you specify to grant access rights to users dynamically.

Configure DAPs as follows:

Step 1 Choose Configuration > Remote Access VPN > Network (Client) Access or Clientless SSL VPN 
Access > Dynamic Access Policies > Add or Edit.

The Add or Edit Dynamic Policy window opens (Figure 7-1).
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Figure 7-1 Add Dynamic Access Policy

Step 2 Use the Policy Name field at the top of the window to name the DAP.

Step 3 Select the ANY, ALL, or NONE option in the drop-down list on the left side of the Selection Criteria 
area.

Step 4 Click the Add button on the left to specify AAA attribute type and values, then click OK. Repeat for 
each AAA attribute to use for this DAP.

Step 5 Move the mouse to the right of the Endpoint Attribute table and click Add.

The Add Endpoint Attribute window opens (Figure 7-2).
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Figure 7-2 Add Endpoint Attribute

Note If the Endpoint Assessment or Advanced Endpoint Assessment option on the Secure Desktop 
Manager > Host Scan pane is checked and you select Antispyware, Antivirus, or Personal 
Firewall, ASDM populates the Vendor ID and Vendor Description drop-down menus. Otherwise, 
it shows blank fields next to the Vendor ID and Vendor Description attribute names.

Step 6 Select one of the following values next to Endpoint Attribute Type:

 • Antispyware (active only if you checked a Host Scan extension in the Host Scan pane)

 • Antivirus (active only if you checked a Host Scan extension in the Host Scan pane)

 • Device to specify any of the following: host name, MAC address, port number, privacy protection 
for Cache Cleaner or Secure Desktop, version of CSD, and version of the Endpoint Assessment.

 • File specified in the Basic Host Scan table in the Secure Desktop Manager > Host Scan pane

 • Operating System

 • Process specified in the Basic Host Scan table in the Secure Desktop Manager > Host Scan pane

 • Personal Firewall (active only if you checked a Host Scan extension in the Host Scan pane)

 • Policy to match a configured prelogin policy

 • Registry (key) specified in the Basic Host Scan table in the Secure Desktop Manager > Host Scan 
pane

The Add Endpoint Attribute window displays the attributes and options associated with the Endpoint 
Attribute Value you select.

Step 7 Select the value of the endpoint attribute type and configure any match criteria associated with that value 
that you want to require.

Step 8 Click OK.
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The Add or Edit Endpoint Attribute window closes, leaving the Add or Edit Dynamic Policy window 
open.

Step 9 Complete the configuration of any other endpoint attributes to specify any other criteria you want to use 
to identify the remote access devices for which the DAP applies.

Step 10 Click Continue or Terminate in the Action tab to specify whether to assign the attributes of this policy 
to sessions that match its criteria or terminate those sessions.

Step 11 (Optional) Enter a text message in the User Message box. See the online help for details.

Step 12 Set the attribute values in the tabs at the bottom of the Add Dynamic Access Policy window to configure 
access rights and restrictions as described in the online help, and click OK.
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Customizing User Banners and Backgrounds

This chapter describes how to change the appearance of CSD. You can use ASDM to change the Secure 
Desktop background (the vault with the lock icon) and its text color, and the dialog banners for the 
Desktop, Cache Cleaner, Keystroke Logger, and Close Secure Desktop windows.

Custom banners and backgrounds are supported on remote PCs running the following Windows OSs:

 • 32-bit Windows Vista—KB935855 or Windows Vista SP1 (or later) must be installed.

 • 32-bit Windows XP SP2 and SP3.

This section includes the following topics:

 • Changing the Secure Desktop Text Color

 • Dialog Windows Displayed to Remote Users

 • Changing the Banners and Background
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Changing the Secure Desktop Text Color
You can change the text color of the three options displayed on the Secure Desktop (vault). These options 
are located in the bottom right corner of the Secure Desktop (Figure 8-1):

Figure 8-1 Secure Desktop Text Color

To change the color of these options, go to Configuration > Remote Access VPN > Secure Desktop 
Manager > Secure Desktop Customization. The Secure Desktop Customization panel opens 
(Figure 8-2). 

Click Color and choose Custom. Select a color from the swatch or using the HSB and RGB tabs.

Figure 8-2 Changing the Text Color of the Secure Desktop
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Dialog Windows Displayed to Remote Users
This section shows the various dialog windows and Secure Desktop background displayed to remote 
users. The Cache Cleaner dialog (Figure 8-3) displays information about the installation of Cache 
Cleaner and its status:

Figure 8-3 Cache Cleaner Dialog

The Close dialog window (Figure 8-4) opens when you close Secure Desktop:

Figure 8-4 Close Dialog Window
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The Keystroke Logger Detector dialog (Figure 8-5) opens after scanning the computer for possible 
keystroke logger programs:

Figure 8-5 Keystroke Logger Detector Dialog

Various message dialog windows (Figure 8-6) open for the Secure Desktop, Keystroke Logger, and 
Cache Cleaner:

Figure 8-6 Message Dialog
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The Secure Desktop background (Figure 8-7) displays in the Secure Desktop. There is no banner for this 
image. Your custom file replaces the entire background:

Figure 8-7 Secure Desktop Background
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Changing the Banners and Background
By default, the banner area of the dialog windows contains the Cisco logo and title Secure Desktop for 
SSL VPN. Figure 8-8 shows an example dialog window and the banner area. 

Figure 8-8 Banner Area of Dialog Windows

You can import your own image file to replace the banners of the four dialog windows. You can also 
replace the entire Secure Desktop (Vault) background with your own background image.

The supported file formats are JPEG, GIF, and PN G. The image can be any size, and is scaled to fit the 
banner area. Table 8-1 provides the approximate banner size for each dialog so you can create a banner 
that scales well.

To replace a banner, you import your own banner image to the security appliance. If you have an image 
that you imported previously to Web Contents, you can use that image also, as described in Step 7 of the 
following procedure.

Note The following instructions assume you are using ASDM 6.1 or earlier.

To import a new image, follow these steps:

Step 1 Choose Remote Access VPN > Clientless SSL VPN Access > Portal > Web Contents and click 
Import.

The Import Web Content window opens.

24
35

46

Banner

Table 8-1 Banner Sizes

Dialog Banner Approximate Size

Cache Cleaner Dialog Banner 320 x 40

Close Dialog Banner 420 x 80

Keystroke Logger Detector Dialog Banner 630 x 40

Message Dialog Banner 320 x 40
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Figure 8-9 Import Web Content

Step 2 Click Browse Local Files, select the image file to import, and click Select.

ASDM inserts the path to the file into the Path box.

Step 3 Click No under Destination.

Step 4 Click Import Now.

Step 5 Click OK in the confirmation dialog box.

Step 6 Continue with the next instruction to insert a previously imported image.

Step 7 To insert an image that you imported previously to Web Contents, click Edit and choose Edit Using 
Device Web Contents (Figure 8-10). Choose a file from Web Contents.
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Figure 8-10 Using a Banner Image Previously Imported to Web Contents

After importing an image, the panel displays a preview of that image. Depending on the speed of your 
connection, it may take ASDM up to 40 seconds to display each image.
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Configuring the Logging Level

By default, CSD 3.4.1 does not log events on the VPN user’s endpoint. Use these instructions to change 
this setting and choose the severity, called the level, of the CSD events to be logged.

The logging level applies to all VPN users except for those made exempt by the “Do not run Cisco Secure 
Desktop” setting in the Connection Policies > Network (Client) Access or Clientless SSL VPN Access 
> Connection Profiles > Add or Edit > Advanced > (Client) SSL VPN panel.

CSD installs the hostscan.log file in the user’s home folder. The hostscan.log file shows only the entries 
from the last session. Each time the user connects to the security appliance, CSD clears the entries from 
this file and records the new data to it. Previous versions of CSD also recorded entries to a file named 
csd.log, also in the user’s home folder. Releases beginning with CSD 3.4.1 record only to the 
hostscan.log file. If the Logging Level is set to the default setting, Off, CSD deletes both the hostscan.log 
and csd.log files if they are present, when users connect.

To view or change the logging level, choose Secure Desktop Manager > Global Settings. The Global 
Settings panel opens (Figure 9-1).
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Figure 9-1 Global Settings

Use the Logging Level definitions in the panel to change the setting.

Click Apply All to save the changes to the running configuration.
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CSD File Reference

The following sections identify the CSD files on the adaptive security appliance and computers 
connecting to the VPN:

 • Adaptive Security Appliance

 • Connecting Computers

Adaptive Security Appliance
Beginning with Version 3.4, the name format and target location of the CSD image is 
disk0:/csd_<n>.<n>.*.pkg. The image name format of versions earlier than 3.4 is 
securedesktop_asa_<n>_<n>*.pkg. The latest CSD image includes the Host Scan updates and Advanced 
Endpoint Assessment (AEA) remediation software. You must install and retain this image on the flash 
device of the ASA to enable CSD. To use the AEA, you must have an AEA license.

The adaptive security appliance config file retains the configuration settings in the Secure Desktop 
Manager > Setup panel when you click Apply All in that window. When you enable Secure Desktop 
Manager, it reads all other CSD configuration data from the disk0:/sdesktop/data.xml file on the flash 
device of the security appliance. Secure Desktop Manager automatically generates this file if it is not 
present. If you click Apply All in any other Secure Desktop Manager window, Secure Desktop Manager 
records the changes to the data.xml file. If you click Reset All in any Secure Desktop Manager panel 
other than Setup, Secure Desktop Manager replaces all data in the data.xml file with the factory default 
settings. Deleting the data.xml and enabling Secure Desktop Manager accomplishes the same result.

The ASDM Tools > Backup Configurations and Restore Configurations options let you back up and 
restore both the /sdesktop/data.xml file and CSD image.

You can also transfer a copy of the /sdesktop/data.xml file to the flash device of another ASA before 
enabling CSD on it if you want to duplicate the CSD configuration.
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Connecting Computers
Connecting Computers
CSD 3.4.1 records log entries only to the hostscan.log file in the user's home folder. The location is 
dependent on the OS and VPN method, as follows:

 • Microsoft with AnyConnect Client start before logon (SBL): 
WINDOWS\system32\config\systemprofile\Application Data\Cisco

 • Microsoft without SBL: %APPDATA%\Cisco\Cisco HostScan

 • Apple Mac OS and Linux: ~/.cisco/hostscan (also accessed through $HOME/.cisco/hostscan). Both 
paths are case-specific.
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A

Advanced Endpoint Assessment     1-3

Allow e-mail applications to work transparently, 
attribute     6-12

B

Basic Host Scan     1-2, 3-1

bookmarks     6-13

browser

home page and favorites     6-12

restrict     6-10

C

Cache Cleaner

instructions     6-5 to 6-6

Use Module, attribute     6-2

Windows     6-5

Check for keystroke loggers, attribute     4-13, 6-3

Checksum, attribute     5-7

Clean the whole cache in addition to the current session 
cache, attribute     6-6

command prompt, disable     6-12

configuration settings, transfer to another security 
appliance     1-9

Customize bookmarks, pane     6-13

Customize bookmarks, window     6-13

D

data.xml     1-9

Default prelogin policy     1-8
delete See Secure Delete

deleting files     6-12

desktop switching     6-7

Disable access to network drives and network folders, 
attribute     6-11

Disable access to removable drives and removable folders, 
attribute     6-12

Disable Cancel button, attribute     6-6

Disable command prompt access     6-12

Disable printing, attribute     6-12

Disable registry modification, attribute     6-12

DoD delete See Secure Delete

Does not exist, criterion for a registry key or file     5-5

drive access     6-11, 6-12

Dword     5-4, 5-5

E

e-mail     6-12

Enable Secure Desktop inactivity timeout, attribute     6-8

Enable switching between Secure Desktop and local 
desktop, attribute     6-7

Enable Vault Reuse, attribute     6-8

encryption     6-9

Endpoint Assessment     1-3

Exists, criterion for a file     5-7

Exists, criterion for a registry key or file     5-4

F

favorites     6-13

file criteria     5-2

folders in favorites or bookmarks     6-13
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Force admin control on list of safe modules, 
attribute     4-13, 6-3, 6-4

Force application uninstall upon Secure Desktop closing, 
attribute     6-8

G

global settings     1-8, 9-1

H

Hidden URL, attribute     6-6

hives     3-5, 5-4

HKEY_CLASSES_ROOT     3-5, 5-4

HKEY_CURRENT_USER     3-5, 5-4

HKEY_LOCAL_MACHINE     3-5, 5-4, 5-5

HKEY_USERS     3-5, 5-4

Home Page, attribute     6-13

home prelogin policy, example configuration     1-4, 4-1

Host Scan     1-8

hostscan.log     A-2

I

inactivity timer     6-8

installing CSD     2-1

IP address     5-10

K

Keystroke Logger     1-8, 4-12 to 4-13, 6-3 to 6-4

L

Launch cleanup upon closing of all browser instances, 
attribute     6-6

Launch cleanup upon timeout based on inactivity, 
attribute     6-6, 6-8

Launch hidden URL after installation, attribute     6-5
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Launch the following application after installation, 
attribute     6-9

List of Safe Modules, pane     6-3

local desktop, switch     6-7

Logging Level     9-1

N

navigation     1-7

network drive access     6-11

O

Open following web page after Secure Desktop closes, 
attribute     6-9

P

Prelogin Policy

example configuration     4-1

menu option     1-8

printing     6-12

public prelogin policy, example configuration     1-4, 4-2

R

registry

criteria     5-2

disable modification     6-12

removable drive access     6-12

Restrict application usage to the web browser only, 
attribute     6-10

restricted mode     6-10

reusing CSD settings     1-9

S

safe modules     4-13, 6-4

secure, example configuration     1-4, 4-1, 5-10



 

Index
Secure Delete

Cache Cleaner     6-6

Secure Desktop     6-9

Secure Desktop

Browser     1-8, 6-12

configuring     5-1, 6-1

force uninstall     6-8

General     1-8, 6-7 to 6-9

inactivity timeout     6-8

local desktop switch     6-7

Manager, establishing a session     1-7

open web page when closing     6-9

prompt to uninstall     6-8

Settings window     1-8, 6-10 to 6-12

Suggest application uninstall, attribute     6-8

Use Module, attribute     6-2

Vault Reuse, attribute     6-8

Secure Desktop Customization menu option     1-8

Show success message at the end of successful installation, 
attribute     6-6

String value, attribute of a registry key as an endpoint 
criterion     5-5

Suggest application uninstall upon Secure Desktop 
closing, attribute     6-8

T

Timeout after, attribute     6-6, 6-8

transparent e-mail     6-12

U

URLs on home page and favorites     6-12

W

whitelist See Restrict application usage to the web browser 
only
 

X

xml     1-9
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